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ISTIKLAL MARSI

Korkma, sonmez bu safaklarda yiizen al sancak;
Sonmeden yurdumun tistiinde tiiten en son ocak.
O benim milletimin yildizidir, parlayacak:;
O benimdir, o benim milletimindir ancak.

Catma, kurban olayim, ¢ehreni ey nazh hilal!
Kahraman irkima bir giil! Ne bu siddet, bu celal?
Sana olmaz dokiilen kanlarmuiz sonra helal.
Hakkidir Hakk’a tapan milletimin istiklal.

Ben ezelden beridir hiir yasadim, hiir yasarim.
Hangi ¢ilgin bana zincir vuracakmis? Sasarim!
Kiikremis sel gibiyim, bendimi ¢igner, asarim.
Yirtarim daglari, enginlere sigmam, tagarim.

Garbin afiakimi sarmussa celik zirhli duvar,
Benim iman dolu gégsiim gibi serhaddim var.
Ulusun, korkma! Nasil béyle bir imam bogar,
Medeniyyet dedigin tek disi kalmig canavar?

Arkadas, yurduma algaklar1 ugratma sakin;
Siper et gévdeni, dursun bu hayasizca akin.
Dogacaktir sana va’dettigi giinler Hakk in;
Kim bilir, belki yarin, belki yarindan da yakin.

Bastigin yerleri toprak diyerek gegme, tanu:
Diisiin altindaki binlerce kefensiz yatani.
Sen schit oglusun, incitme, yaziktir, atani:
Verme, diinyalan alsan da bu cennet vatan.

Kim bu cennet vatamin ugruna olmaz ki feda?
Sitheda figkiracak toprag siksan, sitheda!
Cani, canan, biitiin varinu alsin da Huda,
Etmesin tek vatanimdan beni diinyada ciida.

Ruhumun senden ilahi, sudur ancak emeli:
Degmesin mabedimin ggsiine namahrem eli.
Bu czanlar -ki sehadetleri dinin temeli-

Ebedi yurdumun tistiinde benim inlemeli.

O zaman vecd ile bin secde eder -varsa- tasim,
Her cerihamdan [lahi, bosanip kanli yagim,
Figkirir ruh-1 miicerret gibi yerden na’sim;

O zaman yiikselerck arsa deger belki bagim.

Dalgalan sen de safaklar gibi ey sanli hilal!
Olsun artik dokiilen kanlarimin hepsi helal.
Ebediyyen sana yok, irkima yok izmihlal;
Hakkidir hiir yasamig bayragumin hiirriyyet;
Hakkidir Hakk’a tapan milletimin istiklal!

Mehmet Akif Ersoy



GENCLIGE HITABE

Ey Turk gengligi! Birinci vazifen, Tirk istiklalini, Tirk Cumhuriyetini,
ilelebet muhafaza ve miidafaa etmektir.

Mevcudiyetinin ve istikbalinin yegane temeli budur. Bu temel, senin en
kiymetli hazinendir. Istikbalde dahi, seni bu hazineden mahrum etmek
isteyecek dahili ve haricl bedhahlarin olacaktir. Bir giin, istiklal ve cumhuriyeti
miidafaa mecburiyetine diisersen, vazifeye atilmak i¢in, i¢inde bulunacagin
vaziyetin imkan ve seraitini disinmeyeceksin! Bu imkan ve serait, ¢ok
namiisait bir mahiyette tezahiir edebilir. Istiklal ve cumhuriyetine kastedecek
dismanlar, butiin diinyada emsali goriilmemis bir galibiyetin mimessili
olabilirler. Cebren ve hile ile aziz vatanin biitiin kaleleri zapt edilmis, biitiin
tersanelerine girilmis, biitiin ordulart dagitilmis ve memleketin her kosesi bilfiil
1sgal edilmis olabilir. Biitiin bu seraitten daha elim ve daha vahim olmak tizere,
memleketin dahilinde iktidara sahip olanlar gaflet ve daladlet ve hatta hiyanet
iginde bulunabilirler. Hattd bu iktidar sahipler1 sahsi menfaatlerini,
mistevlilerin siyasi emelleriyle tevhit edebilirler. Millet, fakr u zaruret iginde
harap ve bitap diigsmiis olabilir.

Ey Tiirk istikbalinin evladi! Iste, bu ahval ve serait icinde dahi vazifen,
Turk 1stiklal ve cumhuriyetini  kurtarmaktir. Muhta¢ oldugun kudret,
damarlarindaki asil kanda mevcuttur.

Mustafa Kemal Atatiirk
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guncelleme
yapilacak

anttim Grafigi

Ogrenme biriminin
adini gosterir.

Ogrenme biriminin
karekodunu gésterir.

Ogrenme biriminde yer
alan konulari gésterir.

Ogrenme biriminin
numarasini gosterir.

Ogrenme biriminin giris
kapaginin adini gésterir.

Ogrenme biriminde yer
alan kavramlari
gosterir.
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Ogrenme biriminde
neler égrenilecegini
gosterir.

Konu bashigini
gosterir.

Hazirlik ¢alismalar
alanini gésterir.

Konu anlatimini
gOsterir.

12

Ogrenme biriminin
adini gosterir.




Uygulama alanini
gosterir.

P ——— == -

Etkinlik alanini
gosterir.

Bu ders materyalinde 6lcl birimlerinin uluslararasi kisaltmalari kullaniimistir.

DERS MATERYALIN TANTIM

Ol¢me ve degerlendirme
alanini gésterir.
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OGRENME
® BIRIMI

“ TAKVIM
TASARIMI

KONULAR

1.1. TAKVIM TASARIMI
1.2. KOLAJ VE MONTAJ ISLEMLERI

1.3. BILGISAYARDA TAKViM OLUSTURMA
NELER OGRENECEKSINiz?

* Takvim cesitleri ve 6zellikleri

* Takvim tasariminda dikkat edilecek hususlar

* Kolaj ve montaj araclari, bu araclarin 6zellikleri ve dik-
kat edilecek hususlar

* Takvim tasarimi eskiz caligsmasi olusturma

» Eskiz calismasini bilgisayara aktarma

* Bilgisayar ortaminda gerekli programlarda takvim ta-
sarimi olusturma

* Takvim tasarimini baskiya hazir hale getirme

TEMEL KAVRAMLAR
zaman » duvar takvimi - gemici takvimi
piramit takvim - kolaj * montaj
CTP - kaplama

HAZIRLIK CALISMALARI

1. Sizce takvim hangi amac icin kullanilir?

2. Takvim bir ihtiyac midir? Fikirlerinizi sinif
arkadaslarinizla paylasiniz.

3. Takvimin bir grafik Urinia oldugunu disuniyor
musunuz? Neden?
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zmwm TASARIM

1.1.TAKVIM TASARIMI

Endustri devrimi ile birlikte olusan ¢agin yeni kosullari, toplumsal hayati ve dolayisiyla giindelik
yasami sekillendirmekteydi. Yasamin hareketliligini yakalamak adina zamani programlamak zo-
runlu hale geldi. Bu durum, grafik tasarim Urdnleri icinde dnemli bir yere sahip promosyon mater-
yali olan takvimi insanlarin vazgecilmez araclarindan biri héline getirdi.

1.1.1. Takvim

Zamanin yuzyil, yil, ay, hafta ve giin olarak parcalara bélintp dizenli bir sirayla gdsteril-
digi cizelgelere takvim denir. Takvim, kronolojik bir zaman cetvelidir. Sureler, Giines ve Ay
doéngusu gibi astronomik olaylar ile sularin yikselmesi ve ¢ekilmesi gibi bazi dogal olaylar
Uzerinden belirlenir.

Bircok uygarlik ve toplum 6zel ihtiyaglarina uygun takvim modelleri gelistirmistir. Diinyada
en c¢ok hicri ve miladi takvimler kullaniimaktadir. Hicri takvim, Ay’a gdre hazirlanmistir ve
Hz. Muhammed’in Mekke’den Medine’ye hicretini baslangi¢ olarak alir. Miladi takvim ise
Glines’e gbre hazirlanmistir ve Hz. isa’nin dogumunu baslangic olarak alir.

1.1.2. Takvim Cesitleri ve Ozellikleri

insanlarin glinliik yasamlarinda islerini planlamada yararlandigi takvimin kullanim amaglari-
na gore cesitleri mevcuttur.

Duvar Takvimi: Kullanim sirasinda konumlandigi alanlar duvarlardir. Misteri istegine gore
gunlik (blok), aylik, G¢ aylik (4 yaprak) ve yillik (poster) olarak tasarlanabilen takvimlerdir
(Gorsel 1.1).

gl kufucu

Promosyon; potansiyel musterileri-
ne kendilerini tanitmak, akilda yer
etmek, Urinlerini pazarlamak ama-
ciyla firmalarin kullandigi tanitim
aracidir.

Pt

5a G Fa Cu

1 2 3
1 6 27 B 8 0
213 16 15 18 17
«20 21 22 23 24
s 27 28 29 30 3

| o1

Gorsel 1.1: Duvar takvimi
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Masa Takvimi (Piramit Takvim): Ofis ve |
evlerde masa Uuzerinde kullaniimak Uzere
cift tarafli olarak tasarlanan takvimlerdir.
Takvim cesitlerinde farkli ciltleme yontemleri |
kullaniimakla birlikte masa takvimlerinde her
iki yuzU birden gdsterebilmek icin genellikle
spiral ciltleme yoéntemi tercih edilmektedir
(Gorsel 1.2).

Gemici Takvimi: Promosyon Urlnleri icinde en
cok tercih edilen takvim cesididir. Bir 6nceki,
icinde bulunulan ve bir sonraki ay olmak Uzere
Uc ay! birden gérme imkéani sunar. Gemiciler,
¢ok uzun yolculuklara cikabileceklerinden
ugramalari gereken limanlar planlarlar. Bu
nedenle denizcilik firmalari gemici takvimi
kullanmay tercih eder (Gérsel 1.3).

Ozel Tasarim Takvim: Kullanim yeri, 8lcisi
ve tasarimi musteri istegine gdre degiskenlik
gosteren takvim cesididir (Gorsel 1.4).
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Gorsel 1.4: Ozel tasarim takvim
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’TA\&VIM TAGARM|

Ekim 2021 e
Pzt Sal Gar Per Cum Cmit
1EK 2 3
Multimedya Takvim: Bilgisayar, cep te-
lefonu ve tabletlerde var olan takvimler- ) y ) ’ ’ ’ '
dir. Bazilari herhangi bir kurumsal bilgiye
sahip degildir, sadece tipografik diizenle- " ‘2 o 1 ® “ v
meden olusur. Bazilarinda ise kurumsal
bilgiler mevcuttur (Gorsel 1.5). ® © 2 2 2 2 o
25 6 n 28 29 30 3

Goérsel 1.5: Multimedya takvim

|. Etkinlik

Gorsel 1.6’daki takvim cesitlerinin isimlerini verilen bosluklara yaziniz.

x

Gorsel 1.6: Takvim cesitleri
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1.1.3. Takvim Tasariminda Dikkat Edilmesi Gerekenler

Takvim, zamani programlama iglevinin yani sira kurumsal bilgiler vererek tanitim niteligi de ka-
zanmistir. Tipografik 6gelerin (sayi ve yazilar) tasarim 6gesi olarak kullaniimasi ve tasarim Urin-
lerine yer verilerek akilda yer etmenin de kurumsal kimlik agisindan etkili bir ydntem olmasi ile
daha sanatsal takvim tasarimlari yapilir hale gelmistir. Kurum ya da kisiler adina trtin ve hizmet-
lerin sergilenip hedef kitlelere ulastiriimasinda etkin rol oynayan takvim, basili ve dijital reklam
araclarindan biridir. Bu baglamda tasarim asamasinda dikkate alinmasi gereken birtakim 6geler
mevcuttur.

Takvimi olusturan elemanlar; kurumsal bilgiler, iletisim bilgileri, gérseller, hafta sayisi, giin sayisi,
gln adlari, tatil gtinleri, ait oldugu ay ve ait oldugu yildir. Bu elemanlarin, sayfa tasarimi ve tasari
ilkeleri agisindan butinle ve kendi iginde birbirleri ile uyumlu olmasi gerekir. Ayrica takvimin kul-
lanilacagi alan her agidan g6z éniinde bulundurulmalidir.

Renk Secimi: Tasarimda kullanilacak renkler, kurumsal renklerle uyum iginde ve estetik agidan
tamamlayici nitelikte olmalidir. Renklere musteri ile karar verilmelidir. Secilen renk; gérunarlik,
algilanabilirlik, dikkat cekicilik ve tasari ilkeleri g6z éniinde bulundurularak kullaniimalidir.

Font Secimi: Kuruma ait 6zel bir font varsa o kullaniimalidir, yoksa kuruma uygun olan bir font
secilmelidir. Font seciminde takvim c¢esidi de g6z éniinde bulundurularak fontun okunakli, anla-
silir ve gorulebilir oimasina dikkat edilmelidir. Yazilar, duvar ve gemici takvimlerinde gérinarliuk
acisindan daha buyuk 6lculerde kullaniimahdir. Masa takviminde ise daha kicuk dlgulerde kul-
lanilabilir.

Gorsel Secimi: Takvim musteri istegine gore sanat ve tasarim ile ilgili olabilecegdi gibi kurumsal
tanitim ile ilgili de olabilir. Bu gorseller; fotograf, vektorel ¢izim ve grafiklerden olusabilir. Segilen
gorseller, duvar ve gemici takvimlerinde biyUk dlctlerde; masa takviminde daha kiguk 6l¢tlerde
kullanilabilir.

Basilacak Malzeme: Duvar, gemici ve masa takvimlerinde kalip bélimleri (takvimin ciltlendigi
kapak kismi) kalin ve dayanikli malzemelerden (400 g kroma karton) olmalidir (Gérsel 1.7). ic
yapraklardan olusan ay bdlimleri, ince formalardan (kuse k&git) olabilir (Gorsel 1.8).

Gérsel 1.7: Kroma karton Gorsel 1.8: Kuse kagit
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1.1.4. Takvim Eskiz Calismasi
Eskiz ¢alismasina baslamadan énce musteri ile karar verilmesi ge-
reken bazi hususlar vardir.

® Hangi gesit takvim olacak?

® Kag adet basilacak?

* Ne tur gorseller kullanilacak?

® Hangi renkler kullanilacak?

® Hangi font kullanilacak?
Takvim ¢esidi; takvimin 6l¢tsund, ne tir malzemeyle yapilacagini
ve iginde kullanilacak tasarim égelerinin 6l¢ct ve konumunu belir-
lemek i¢in kullanilir. Takvim ¢esidinden dolayi degisiklik gdsteren
basim malzemesi ve 6l¢l, ayni zamanda fiyatta da degiskenlige
sebep olur. isin adeti ve fiyati, teslim siiresini ve baski cesidini be-
lirlemek icin kullanilir. Ayrica kurum yetkililerinden, kurum bilgisi
bélimdinde kullaniimak Gzere firma logo, amblem, logotype zemi-
ninin transparan hali temin edilmelidir.

Takvim Olcii ve Malzemeleri

Her ne kadar giinimuzde standart élculer yerine 6zel dlgller daha
cok tercih edilse de misteri aksini belirtmedigi takdirde takvim 6lgu
ve malzemeleri Gorsel 1.9'daki gibidir.

Duvar takvimi Duvar takvimi Duvar takvimi
1 2 3
Poster takvim 4 yaprak takvim Blok takvim Gemici takvimi
31x44 cm 31x44 cm 31x44 cm Kafa 31x23 cm

400 g mat selefonlu Amerikan bristol

12 yaprak 31x22 cm
70 g 1. kalite hamur

400 g kroma karton 90 g kuse kagit 400 g kroma karton

Masa takvimi
21x14 cm
400 g bristol
12 yaprak 21x12 cm
157 g kuge kit

Gorsel 1.9: Takvim cesitleri, élguleri ve malzemeleri
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Duvar takvimi Gemici takvimi Masa takvimi

Takvim Eskizi Olusturma

Garsel alan

Garsel alan Garsel alan

Kurumsal bilgiler alan

Tipografik bilgiler alani
Kurumsal bilgiler alani

Kurumsal bilgiler alam

Gorsel 1.10: Takvim cesitleri eskiz calismasi

Olusturulan eskiz ¢alismalarindan uygun olan bir tanesi segilir, dizeltme gerekiyorsa yapilir, dijital
ortama aktariimak tzere calismaya son héli verilir.

2. Etkinlik—

Takvim tasarimini yapabileceginiz hayali bir firma ismi belirleyiniz. Asagidaki
maddeleri g6z 6niinde bulundurararak belirlediginiz firmaya ait takvim tasarim
eskizi hazirlayarak arkadaslarinila paylasarak degerlendiriniz.

2. Firma bilgileri

1. Firma adi 3. Diger firma adlar:

9. Fon‘ré_,z_\ /SJ‘L Takvim 6rnekleri

8. Renk / renkler/ \/N 5. Takvim cesidi

7. Gorsel tiurd 6. Adet J

21

anttim Grafigi




Tanitim Grafigi

zFAk\/iM TASARM

OGRENME BiRiMi: TAKVIM TASARIMI
UYGULAMA ADI : Takvim Eskizi Hazirlama

g AMAC : Takvim tasarimi igin gerekli 6n hazirliklari yapmak.
S Arac Gerec

é‘J 1. 2. Etkinlik’teki bilgi dosyasi

> 2. Eskiz sayfalari

— 3. Kalem

—= 4. Cetvel

Gorsel 1.11°deki takvim eskizini inceleyiniz. Siz de belirlediginiz firma icin asagi-
daki islem basamaklarini dikkate alarak li¢c adet takvim eskizi hazirlayiniz.

Tipografik
bilgiler alani

o) - Kurumsal
Gorsel bilgiler [
alan alani

Gorsel 1.11: Takvim eskiz calismasi

islem Basamaklari

1. Atélye 6nlugunuza giyiniz; ara¢ gerecinizi, ¢alisma alaninizi is saghgi ve
glvenligi tedbirlerini alarak 6zenle hazirlayiniz.

2. 2. Etkinlik’te hazirladiginiz bilgi dosyanizi ¢ikariniz.

Dosyanizdaki bilgiler dogrultusunda eskiz ¢alismanizi giziniz.

4. Musteriye alternatif calismalar sunabilmek igin farkl versiyonlarda U¢ eskiz ca-
lismasi hazirlayiniz.

5. Degerlendirme kriterlerini dikkate alarak U¢ eskiz ¢calismasindan bir tanesini 6g-
retmeniniz ile birlikte seginiz.

w

6. Secilen eskiz calismasinda gerekiyorsa diizeltmeler yaparak eskize son halini veriniz.
Degerlendirme

Uygulama calismanizin suresi 6gretmeniniz tarafindan belirlenecektir. Calismaniz,
1. Ek’te verilen “Degerlendirme Formu” veya “Kontrol Listesi’ndeki dlgltlere goére
degerlendirilecektir. Calismanizi yaparken bu élgutleri dikkate aliniz.
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1.2. KOLAJ VE MONTAJ iSLEMLERI

Farkl malzemelerin bir ylzey Uzerinde bir araya getiriimesiyle olusturulan kompozisyona kolaj
denir. Gazete kagidi, fotograf vb. nesneler yapistirilarak, gerekli durumlarda boya ile de midaha-
le edilerek uygulanir. Kolaj ayrica dijital ortamlarda farkli fotograflarin birlestiriimesiyle ya da tek
bir fotografin bélinmesiyle de uygulanabilen bir resimleme teknigidir. Yazi ve rakamlarin yani sira
gorantiler de tasarim dgesi oldugundan takvim tasariminda kolaj teknigi ile goértintu diizenlemek
yerinde olur. Matbaacilikta kullanilan temel hesaplama birimlerinden biri olan ve sekiz 6n, sekiz
arka olmak Gzere on alti sayfadan olusan bdlime forma denir. Coklu sayfa tasarimlarinda, ¢alis-
manin baskiya hazir halde k&gida yerlestirimesine de montaj denir.

1.2.1. Kolaj ve Montaj isleminde Kullanilan Araglar ve Ozellikleri

Kolaj islemi, bircok program ile yapilabilir. Kullanilacak géruntinun fotograf olmasi durumunda
piksel tabanl gorintd dizenleme programi kullanilir (Gérsel 1.12).
Kolaj ve montaj islemi icin kullanilacak araclar, paneller ve komutlar sunlardir:

* File > New (fayil > niv) komutu ile 6zellikler verilerek yeni ¢calisma sayfasi acilir.

* File > Place (pileys) komutu ile gérintt ya da goéruntuler sayfa icine direkt aktarilir ya
da File > Open (opin) komutu ile gériintd, ayri bir sayfa olarak agilir ve ara¢ kutusundan
Move Tool (muv tuul) ile tasima yapilarak getirilebilir.

* Goruntdlerin tamami degil de belirli bélimleri kullanilacak ise segcme islemi icin segim
araclarindan Marquee Tool (marki tuul), Lasso Tool (laso tuul) kullanilabilir. Secili alani
yeni bir katman olarak kopyalamak icin Ctrl+dJ kisayol tusu kullanilir.

® Calisma sayfasini kesme (kirpma) ve artirma islemi icin Crop Tool (kirap tuul) kullanilir.

* Goruntlye gcergeve eklemek icin Layer (leyir) > Layer Style (sitayl) > Stroke (sitrok) ya
da Layer paneli > Blending Options (bilending opsins) komutu kullanilir.

® Gorlntlye golge vermek icin Layer > Layer Style > Drop Shadows (dirap sadovs) ya
da Layer paneli > Blending Options komutu kullanilir.

* (Calisma sayfasini kaydetmek icin File > Save (seyv) komutu ya da Ctrl+S kisayol tusu
kullanilir. Galisma kayit turt PSD ve JPEG/TIFF formati secilerek kaydedilir.

Tanitim Grafigi

Goérsel 1.12: Dlnyanin yedi harikasi ve doganin yedi harikasi kolaj calismalari
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1.2.2.

Kolaj ve Montaj iglemlerinde Dikkat
Edilecek Hususlar

Kolaj caligmasinin istenen amaca uygun, estetik ve
gdze hos goériinen nitelikte olmasi asagidaki 6zelliklere
dikkat edilerek saglanabilir.

Konuya uygun gérsel se¢imi

Gorsel alan igin ayrilan bolimun, dolayisiyla
da sayfada kullaniimak istenen gorsellerin ya-
tay ya da dikey olmasi

Gorunurlik, netlik ve fark edilebilirlik agisin-
dan 6nemli oldugundan ayrilan bélimde kag
adet gorsel kullanilacagi

Gorsellerin konum itibariyla birbiri ile uyumu
Gorsellerde cergeve kullanilacaksa cerceve-
nin sayfa ve gdrsel ile bicim ve renk uyumu
Gdrseller arasinda birakilan espas degeri
Gorsellerin, sayfa ve birbirleriyle renk ve 1sik
uyumu gibi 6zellikler dikkate alinarak calisil-
masi; kolaj calismasinin istenen amaca uy-
gun, estetik, géze hos gérunen nitelikte olma-
sini saglar.

Mizanpaj isleminde ise 6zellikle coklu sayfa tasarim-
larinda baski ¢esidine (yan yana ya da alt alta) gére
sayfa numarasinin siralanmasina dikkat edilmelidir.

%. Etkinlik

gl kufucu

Bir calisma, kullanilan progra-
min kayit tiriinde kaydedilirse
daha sonra lzerinde dizen-
leme yapilabilir.

lgi Vertue

Calismanin kaliteli gérinme-
si icin, kullanilan gdérsellerin
yuksek ¢6zUnirlik degerleri-
ne sahip olmalidir.

Daha 6nce eskiz calismasi olarak hazirladiginiz takvim tasarimi icin dijitgor-
seller arastiriniz. Konunuza uygun gérselleri belirleyiniz. Kolaj calismasinda
kullanmak tizere tasinabilir bellekte dosyalayiniz.

,

J
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OGRENME BIiRiMi: TAKVIM TASARIMI

3. Piksel tabanli program

g UYGULAMA ADI : Kolaj Calismasi
S AMAC : Takvim tasarimi igin gerekli 6n hazirliklari yapmak.
3 Arac Gerec
@7 1. 3. Etkinlik'teki gé
. 3 gorseller
3 2. Bilgisayar

Gorsel 1.13’teki kolaj calismasini inceleyiniz. Siz de takvim tasariminda kulla-
nilmak Uizere bir kolaj calismasini asagidaki islem basamaklarini dikkate alarak
hazirlayiniz.

Gorsel 1.13: Kolaj calismasi

islem Basamaklar

1. Atélye 6nlugunizu giyiniz; arag gerecinizi, ¢alisma alaninizi is saghgi
ve glvenligi tedbirlerini alarak 6zenle hazirlayiniz.

2. Ogretmeninizle birlikte bir konu belirleyiniz, bu konu ile ilgili gérselleri hazirla-
yiniz.

3 “Kolaj ¢calismasi icin piksel tabanl programda uygun boyutlarda bir sayfa aginiz.

4. Kolaj calismasinda kullanmak lzere hazirladiginiz gérsellerden yeteri ka-
darini ¢calisma sayfasina getiriniz.

5. Kolaj calismasi i¢in piksel tabanli programda gerekli arag, panel ve komut-
lari kullanarak ¢alismanizi yapiniz.

6. Gerekiyorsa dlzeltmeler yaparak calismaniza son hélini veriniz.

7. Calismanizi program kayit ve JPEG formatinda kaydediniz.

Degerlendirme

Uygulama c¢alismanizin suresi 6gretmeniniz tarafindan belirlenecektir. Calismaniz,
1. Ek’te verilen “Degerlendirme Formu” veya “Kontrol Listesi’ndeki dl¢ltlere gére
degerlendirilecektir. Calismanizi yaparken bu 0lgtleri dikkate aliniz.

anttim Grafigi
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1.2.3. Takvim Tasariminda Kolaj ve Montaj

Baslica 6zelligi zaman cetveli olan takvim, gecen zaman icinde sanat ve tasarim Urininu sergi-
leyen, grafik tasarim icin bir yillik sergilenme olanagi taniyan bir grafik Grinu niteligi kazanmustir.
Bu baglamda takvim tasariminda tipografik 6gelerin yani sira gorseller biyiuk 6nem kazanmisg,
takvim gorsel nitelikleriyle 6n plana ¢cikmig ve tasarimin dnemi giindeme gelmistir.

Takvim Tasariminda Kolaj: Olusturulmak istenen takvim cesidine gore (sergilenecegi konum ve
Olcu degiseceginden) gdrsel alana uygun kolaj ¢alismasi yapiimalidir. Kolaj ¢alismasinda kendi
icinde kompozisyon, tasari ve sayfa tasarimi ilkeleri dikkate alinmalidir. Ayrica kolaj calismasinin
tipografik 6gelerle de uyumu mutlaka géz 6ninde bulundurulmalidir. Unutulmamalidir ki takvim
tasaniminda ilk gdsterilmek istenen tipografik 6gelerdir.

. Efkinlik

Teknoloji ile ilgili gbérseller bularak Gérsel 1.14’te sari renk ile gésterilen gor-
sel alanin icine kolaj calismasi yapiniz.

I I AT AT A AL AT AT AL
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Gorsel 1.14

)
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Takvim Tasariminda Montaj: Basilacak islerde baskiya hazirlik asamasi, montaj islemidir. Ca-
lismanin toplam baski adedine, baski makinesi 6zelliklerine, ciltleme ¢esidine, kullaniimak iste-
nen malzeme ve o6lclye gdre diizenleme yapilir. K&git 6lgtstine gore tasarim ¢ogaltilarak yerlesim
yapilir. Calismanin kagit izerine yerlestiriime yéni énemlidir. Ornegin Gérsel 1.15'teki gibi bir A4
kagit alinarak dorde katlanir; ilk sayfadan baglanarak sayfalarin 6n yizinun sag alt, arka yizu-
nin de sol alt kdsesine olmak lzere sayfalara arkali 6nlii numara verilir. Takvim agildiginda sayfa
numaralarinin yéniine gére tasarim yerlestirilir. Sayfalarda ¢alismalarin yiz ytze baktigi géraldr.

ejies 7 wuese] |epies 7 wuese]
Tasanm 6. sayfa Tasanm 3. sayfa
epfes ‘s wuese] | eies ' wuese]
Tasanm 8. sayfa Tasanm 1.sayfa

Gorsel 1.15: Sekiz sayfalik formalama islemi

Ll@i Kutucu

Montaj iglemi i¢in vektdrel tabanh
program kullanilabilir fakat en ide-
al olani ¢coklu sayfa tasarimlarinda
kullanilan “mizanpaj programi”dir.
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D. Etkinlik

Gorsel 1.15’teki gibi bir A4 kagit ile sekiz sayfalik formalama islemi yapiniz.

1.3. BILGISAYARDA TAKViM OLUSTURMA

Modern yasam sonucu toplumsal hayatimiz ve giindelik yasantimizdaki gelismeler, grafik sanat-
lar adina reklam ve tanitimin éne ¢cikmasini saglamig; tasarimlarin ¢ogaltiimasini zorunlu kilmis-
tir. Teknoloji ve dolayisiyla baski tekniklerindeki gelismeler sonucu artik tasarimlar, elde eskizler
olusturulduktan sonra bilgisayar ortamina aktariimakta; programlar araciligi ile gerekli dizenle-
meler yapilabilmekte ve baski asamasi sonrasina kadar getirilebilmektedir.

1.3.1. Secilen Eskiz Calismasini Dijital Ortama Aktarma

Olusturulan eskiz galismasi, tarayici yardimi ile dijital ortama aktarilir. Gorseller, piksel tabanli
programda; tipografik tasarim elemanlari, vektorel tabanli programda calisiimak tzere diizenlenir
(Gorsel 1.16).
Piksel tabanh programda,
* Image (imic) > Adjustments’in (edcastmints) alt secenekleri olan Brightness/Contrast
(biraytnis/kontrast), Levels (levils), Curves (kOrvis) secenekleri ile grafigin arka plani
beyaz olacak sekilde diizenleme yapilabilir.

LI@L Kutuecu

Masaiistii Yayincilik: Tasa-
rim ogelerini bilgisayar orta-
A P minda kullanarak baskiya uy-

nBKMIsET gun tasarim olusturma isidir.
A 18192021222324 S
"'_ 25 26 27 28 2930 31

L
1

Goérsel 1.16: Takvim tasarimi calismasi
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® (Cizgi géranirlugu icin Filter (filir) > Sharpen (sarpin) > Smart Sharpen (si-
mart sarpin) komutu kullanilabilir.
® Gorsel Marquee Tool, Lasso Tool ya da Pen Tool ile kesilip kullanilabilir.

Tasarimi dijital ortamda yeniden olusturmak icin eskiz Pen Tool ile ¢izilir ve Paint (pe-
int), Bucket Tool (bakit tuul), Gradient Tool (girediyint tuul) ya da Brush Tool (biras
tuul) ile renklendirilebilir.

1.3.2. Dijital Ortamda Takvim Tasarimi

Eskiz calismasi ve kurum i¢in hazirlanmis bilgi dosyasi dogrultusunda vektorel tabanli
programda File > New (ctrl+N) komutu ile yeni bir sayfanin genislik, yikseklik ve tasma
payi gibi 6zellikleri dizenlenir. Gorsel alanlar ile kurumsal ve tipografik bilgilere ait bo-
[imler programda gerekli araclar ile sayfa ici 6l¢tlendirme yapilarak dizenlenir.

Sayfa icinde olgculendirme yapabilmek icin asagidaki islemler yapilir.

® View (viu) > Rulers (rulirs) > Show Rulers komutu ile cetvel getirilir. Cetvel
Uzerinde sag tus yapllir, gelen pencereden ¢alismada kullanilacak birim (cm,
mm vb.) segcilir.

* View > Guides (gayds) komutu ile yatayda ve dikeyde yardimci ¢alisma gizgileri
getirilir. Yardimci gizgilerin sayfa icinde konumunun belirlenmesi icin Properties
(pirapirtiis) paneli kullanilir. Cizgilerin tamamini gériinmez yapmak icin View >
Hide Guides (hayd gayds), cizgileri kilitlemek icin View > Lock Guides (lak
gayds), silmek icin ise View > Clear Guides (kiliyir gayds) komutu kullanilir.

Sayfa icinde herhangi bir dgenin élctlendiriimesi icin Transform (tirensform) paneli, ko-
num duzenlemesi icin Properties paneli kullanilir. Konum siralamasi i¢in Layers paneli
ya da sayfa icinde olcllendiriimek istenen dge Uzerine sag tus yapilarak acilan pence-
reden Arrange (ering) komutu kullanilir. Ogeleri sayfada ve kendi icinde hizalamak igin
ise Align (elayn) paneli kullanihr.

Gorsel Alan Boélimii: Piksel tabanli programda dliizenlemesi yapilarak kaydedilen ¢a-
lisma, sayfa icine getirilerek ayriimis bélime yerlestirilir. Sayfada gérsel alan icin ayrilan
bélimde vektdrel bir ¢izim yapilmasi gerekiyorsa Pen Tool, Curvature Tool (kdrvicir
tuul), Rectangle Tool (rektangil tuul), Ellipse Tool (elips tuul), Polygon Tool (poligon
tuul), Star Tool (sitar tuul), Line Segment Tool (layn segmint tuul), Paintbrush Tool
(peintbiras tuul), Blob Brush Tool (bilab biras tuul) ve Pencil Tool gibi ¢izim araclarin-
dan uygun olanlar kullanilabilir.

Kurumsal Bilgiler Béliimii: Onceden hazirlanan bilgi dosyasi dogrultusunda, takvi-
min zemininde kullanilacak renklerin farkli veya ¢oklu renk olma ihtimali géz éntinde
bulundurularak firmanin logotype, logo ya da ambleminin transparan olmasina 6zellikle
dikkat edilmelidir. Ayrica takvimde iletisim bilgilerinin olmasinin da reklamcilik agisindan
olduk¢a 6nemli oldugu unutulmamalidir.
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Tipografik Bilgiler Béliimii: Rectangle Tool ya da Type Tool (tayp tuul) ile aylara ait rakamlarin
dizenlenebilecegi bir alan olusturulur. Alan, Rectangle Tool ile olusturulmus ise alani yazi ala-
nina doénusturmek icin Type Tool ile alan ¢izgisi Uzerine bir kez tiklamak yeterli olur. Yazi alanini
dizenlemek icin Type > Area Type Options (eriya tayp opsins) paneli kullanilir (Gorsel 1.17).

.r Aialjpd Optinea A

Giyphs h "4

Arecﬂvype — : Columns: Siitun
s ! »Fixed: Sabit

Width: Geniglik < -7 »Gutter: Hiicre digi aralik

BEN
Insert Spacing: Ekleme araligi

Rows: Satir <«--

» First Baseline: Ik taban ¢izgisi

Goérsel 1.17: Area Type Options paneli

istenen geniglik degeri Width (vidt), yilkseklik degeri Height (hayt), satir (hafta) sayisi Rows (rous),
sltun (giin) sayisi Columns (kalims), aralarindaki mesafe ayari Span (sipen), rakamlarin hangi
araliklarda eklenecegi Insert Spacing (insort sipeysin) ve hangi ydonde (yukaridan asagiya / soldan
saga) siralanacagi Text Flow (teks filav) komutlari ile uygulanir.

Yazi alaninin sol (st bélimiine imle¢ konumlandirilir. ilk satirda giinler, ikinci satirdan itibaren
sayllar olacak sekilde her glin ve sayidan sonra bir sonraki hiicreye gegmek icin Enter (entir) tusu
kullanilir. Once giinler, ardindan 1’den 31°e kadar sayilar yazilir. Yazi puntosu kiiciik ya da biyiik
oldugunda istenen sonug elde edilemez, punto alana gére belirlenmelidir. Giin isimlerinin yazil-
digi satir ayrica olusturulmak istenirse yine hlcre gegisi icin Enter kullanilarak haftanin ginleri
yazilir. Dizenleme igcin Window > Type > Tabs (tebs) ya da kisayol olarak Shift+Ctrl+T kullanihr
(Gorsel 1.18).

+ Xi Omm Leader:

20 30 |40 S0 |e0 |70 |80 S0 [100 110 [120 |130

Gorsel 1.18: Tabs paneli

Cetveli yazi alanina gbére konumlandirmak icin miknatis simgesine bir kez tiklamak yeterlidir.
ilk hiicrede imlec konumlandirilir ve Left-Justified-Tab (left-castifayd-tab) ile yazilarin sola yas-
lanmasi saglanir. Bu islemin ardindan her bir giinu sola hizalamak i¢in cetvel izerinde istenen
noktaya bir kez tiklamak yeterlidir.
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2. U\ygulama

OGRENME BIRiMi: TAKVIM TASARIMI
UYGULAMA ADI : Bilgisayarda Takvim Hazirlama
AMAC : Bilgisayarda takvim tasarimi yapmak.

Arac Gerec¢

1. Bilgisayar

2. Vektoérel tabanh program

3. Kolaj calismasi

4. Bilgi dosyasi
Goérsel 1.19’daki masa takvimi calismasini inceleyiniz. Siz de asagidaki islem ba-
samaklarini dikkate alarak takvim tasarimini yapiniz.

Ocak
Pt Sa Ca Pe Cu Ct

4 5 6 T 8 9
1 12 13 14 15 16
18 19 20 21 22 23
25 26 27 28 29 30

msal bilgiler alani

Gorsel 1.19: Masa takvimi calismasi

islem Basamaklari
1. Atdlye 6nligindza giyiniz; arag gerecinizi, calisma alaninizi is sagligi ve given-
ligi tedbirlerini alarak 6zenle hazirlayiniz.
2. Ogretmeninizle birlikte takvim tasarimi icin bir konu belirleyiniz. Belirlediginiz
konu ile ilgili kolaj calismasi yapiniz.
3. Calismaniz siresince sabirl ve dikkatli olmaya 6zen gosteriniz.
4. Vektorel tabanh programda yapmak istediginiz takvim cesidi 6l¢gtistinde bir say-
fa aciniz.
5. Takvim tasarimi ¢esidine gore sayfanizda gerekli alanlarin dlgtilendirmesini uy-
gun arag, panel ve komutlari kullanarak yapiniz.
Hazirlamis oldugunuz kolaj calismanizi sayfada gerekli alana konumlandiriniz.
Kurumsal bilgiler ve tipografik bilgiler bélimlerini olusturunuz.
Gerekiyorsa duzeltmeler yaparak ¢alismaniza son hélini veriniz.

9. Calismanizi program kayit formatinda ve JPEG formatinda kaydediniz.

© N o

Degerlendirme
Uygulama calismanizin slresi 6gretmeniniz tarafindan belirlenecektir. Calismaniz,

1. Ek’te verilen “Degerlendirme Formu” veya “Kontrol Listesi’ndeki 6l¢itlere gére
degerlendirilecektir. Calismanizi yaparken bu 6lgitleri dikkate aliniz.
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1.3.3. Takvim Tasarimi Baski islemleri
Bir grafik UrlGn; tasarim, film, kahp ¢ekme, baski, baski sonra-

si olmak Uzere bes asamada gergeklesir. Film ve kalip cekme : i)
asamalar Urun ofset baski olacaksa uygulanir. Dijital baskida P
bu asamalara gerek yoktur. Baski islemleri, tasarimin olusturul- 12 3

112 13 14 15 16 17
Tasarim: Arastirma ile baglar, eskiz ve ardindan bilgisayar orta- 18 19 20 21 2223 24
25 26 27 28 29 30 31

masindan sonraki asamalardir. 45 6 2 \

minda baski agamasina getirilir.

Film: Tasarimi olusturulan ¢calismanin baski isleminde kullanila- i
cak kalibini (Gérsel 1.21°deki aliminyum plaka gibi) olusturmak
icin film ¢ikiglari alinir. Ardindan baskiy! taklit eden yazicilardan

prova baski alinir.

Gorsel 1.20: Takvim tasarimi

Kalip Cekme: Film ¢ikisindan sonra kalip Gzerine tasarimin gé-
rantastnun cikartilmasidir. Filmin kullaniimasi ile pozlandirma
ve banyo (kontakt baski) islemi, CTP [computer to plate (kom-
pudir tu pileyt)] sistemiile film ve montaj islemlerine gerek olma-
dan yapilabilen islem olmak Uzere iki sekilde gerceklesir.

Baski: Ofset baski, dijital baski gibi farkli baski ¢esitleri bulunur.
Grafik Grin cesidine gore baski farkllik gosterir. Tasarimin ilk
olusum asamasindan itibaren hangi baski ¢esidinin kullanilaca-
g1 ve yapilacak islemlerin de bu secime goére degisiklik gbstere-
cegi g6z dnunde bulundurulmahdir.

Baski Sonrasi: Grafik Griniln ¢esidine ve misteri istegine gére
selefon, lak gibi malzemelerle ylzey kaplama islemi yapilabilir.
Cok sayfali grafik Urtinlerde katlama, harmanlama, iplik dikis ya Gorsel 1.21: CTP
da tel dikis gibi islemler; ayrica kitap ve dergi gibi Grlnler igin

kapak takarak ciltleme gibi igslemler ve ambalaj gibi Griinler i¢in

ise kaliph kesim gibi islemler micellithane makinalari kullanila-

rak yapilabilir.

=
&
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-
S
£
=
S
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Gérsel 1.22: iki renkli ofset baski makinasi Gorsel 1.23: Ylizey kaplama malze-
meleri (metalize, sedef, selefon)
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Takvim Tasarim Ornekleri

: &5 6.7
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Gorsel 1.24: Takvim tasarimlari
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Gorsel 1.25: Takvim tasarimlari
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NAALIRNAIN
Pt Ca PeCuc
1 P

8 9

16

7

anttim Grafigi

Gorsel 1.26: Takvim tasarimlari
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Nemrut
Dagi

Nemrut Dag (Kommagene) - Adlﬂmén
MO.1.Yiizyil

Gorsel 1.27: Takvim tasarimlari
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OGRENME BIiRiMi: TAKViIM TASARIMI

2. Vektorel tabanl program

S UYGULAMA ADI : Bilgisayarda Takvim Hazirlama

E AMAC : Bilgisayarda 6zel takvim tasarimi yapmak.
S

= Arac Geregc

g’_ 1. Bilgisayar
=
>

Gorsel 1.28’l inceleyiniz. Siz de asagidaki islem basamaklarini dikkate alarak 6zel
takvim tasarimi yapiniz.

16 272

Gorsel 1.28: Ozel takvim tasarimi

islem Basamaklari

1. Atdlye 6nligunuzi giyiniz; arag gerecinizi, calisma alaninizi is saghgi ve gliven-

ligi tedbirlerini alarak 6zenle hazirlayiniz.

2. Ogretmeninizle birlikte bir konu belirleyiniz, bu konu ile ilgili bilgi dosyasi hazir-
layiniz.
Bilgi dosyasi dogrultusunda eskiz ¢alismalari hazirlayiniz.
Ogretmeninizle birlikte eskizlerden bir tanesini seginiz.
Yapmak istediginiz takvim 6l¢tstnde vektdrel tabanli programda bir sayfa aciniz.
Secilen eskiz ¢alismasi dogrultusunda gerekli arag, panel ve komutlari kullana-
rak takvim tasarimini yapiniz.
7. Gerekiyorsa duzeltmeler yaparak calismaniza son halini veriniz.
8. Calismanizi program kayit formatinda ve JPEG formatinda kaydediniz.

2

Degerlendirme

Uygulama calismanizin suresi égretmeniniz tarafindan belirlenecektir. Calismaniz,
1. Ek’te verilen “Degerlendirme Formu” veya “Kontrol Listesi’ndeki élgutlere gére
degerlendirilecektir. Calismanizi yaparken bu 6lgitleri dikkate aliniz.

Tanitim Grafigi
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OLCME VE DEGERLENDIRME

A) Asagida verilen ciimlelerin basindaki parantezlere ciimleler dogru ise “D”, yanlis ise
“Y” yaziniz.

B)

C)

ok~ 0pnp -

) Takvim, zamani programlamak icin kullanilan bir grafik Grindur.

) Gemici takvimi bir ayi gdsterebilmek Uzere tasarlanmistir.

) Takvim tasariminda 6l¢t, misteri istegine gére degisiklik gésterir.

) Montaj, cok sayfali tasarimlarda ¢alismanin baskiya hazir halde yerlestiriimesidir.

) Tasarim Ogelerini bilgisayar ortaminda kullanarak baskiya uygun tasarim olustur-
maya masausti yayincilik denir.

—_~ o~~~ ~

Asagida verilen ciimlelerde yer alan bosluklari uygun ifadelerle doldurunuz.

6.

Musteri istegine gore gunlik, aylik, G¢ ayhk ve yillik olarak tasarlanan takvim cesidi

.............................. takvimidir.

Takvim tasariminda yazi, sayilarve ..............coovvevevnennnn. tasarim dgesidir.

Takvim tasariminda ilk gdsterilmek istenen ...............c.oocvieenen. Ogelerdir.

Takvimin ......ooeviiiiii, fiyatini, teslim suresini ve baski ¢esidini belirlemek icin gerek-

lidir.

Asagida verilen sorularin dogru cevaplarini isaretleyiniz.

10. Asagidakilerden hangisi ¢coklu sayfa tasarimlarinda ¢calismanin baskiya hazir halde yer-

11.

12.

38

lestiriimesi islemine verilen addir?
A) Baski

B) Kirpma

C) Kolaj

D) Montaj

E) Perforaj

Asagidaki ciltleme cesitlerinden hangisi 6zellikle masa takviminde her iki yizeyi de gés-
terebilmek igin kullanilir?

A) Amerikan cilt

B) Iplik dikis

C) Omega tel dikis

D) Spiral

E) Tel dikis

Asagidaki panellerden hangisi calisma sayfasinda yazi alani diizenlemesi icin kullanilir?
A) Area Type Options

B) Artboards

C) Libraries

D) Pathfinder

E) Type on a Path
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13. Asagidakilerden hangisi ¢calisma sayfasinda él¢llendirme yapabilmek igin kullanilan
cetvel aracinin kisayoludur?
A) Shift+Ctrl+R
B) Shift+R

C) Citrl+P
D) Ctrl+R
E) Ctrl+S
14. Asagidakilerden hangisinde bir grafik Griininin bes asamasi dogru siralamayla ve-
rilmistir?

A) Film, kalip cekme, baski, tasarim, baski sonrasi

B) Film, tasarim, kalip cekme, baski, baski sonrasi
C) Tasarim, film, baski, kalip cekme, baski sonrasi
D) Tasarim, film, kalip cekme, baski, baski sonrasi
E) Tasarim, kalip cekme, baski, film, baski sonrasi

D) Asagida verilen sorularin cevaplarini noktali yerlere yaziniz.

15. Takvim tasarimi yapilirken font seciminde dikkat edilmesi gerekenler nelerdir?

anttim Grafigi
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OGRENME
@® BIRIMI

AFIS
TASARIMI

KONULAR

2.1. AFIS TASARIMI

2.2. BASKALASTIRMA (MANIPULASYON)
2.3. BILGISAYARDA AFiS OLUSTURMA

NELER OGRENECEKSINiz?

* Afis cesitleri ve ozellikleri

* Afis tasarimi icin eskiz calismalar yapma

* Piksel tabanli programda fotograf bagkalastirma (ma-
nipilasyon) calismalari yapma

* Belirlenen afis eskizini dijital ortama aktararak iste-
nen siirede baskiya hazirlama

TEMEL KAVRAMLAR

e afis
* baskalagsim (manipulasyon)

HAZIRLIK CALISMALARI

1. Afis denince akliniza gelenleri sinif arkadaslarinizla
paylasiniz.

2. Daha énce gorduginuz afislerde neler dikkatinizi
cekti?
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2.1. AFiS TASARIMI

TDK Glncel Turkge Soézlik'te “Bir seyi duyurmak veya tanitmak icin hazirlanan, kalabaligin
gorebilecegi yere asilmis, genellikle resimli duvar ilani, asl.” seklinde tanimlanan afis, dilimize
Fransizca “affiche” sdzctuginden turetilerek girmigtir. Afigler; bilgi vermek, tanitim yapmak gibi
amaglarla hazirlanan ve buyuk kitlelere hitap eden grafik Grtnleridir. Afisin genel iglevi, mesajini
direkt ve hizl bir sekilde izleyiciye yansitmaktir. GiinimUze kadar etkinligini ve 6nemini korumus-
tur. insanin oldugu her yere ulagabilmesi, her sektérde ve her alanda uygulanabilir olmasinin
bunda etkisi blyuktir (Gorsel 2.1).

' . ; / .."/ Dmya w
b 42‘

Katihmalor

HAYATIMIZDA® &
w W

N
lmlsm TEL:

SYAL MEDYA HESAPLA

Goérsel 2.1: Afis 6rnegi

anttim Grafigl
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2.1.1. Afis Cesitleri ve Ozellikleri

Grafik tasarim 6geleri icinde basta gelen
afisin kullanim alani oldukg¢a genistir. Kitap
tanitim afisinden dogum gunu afisine, kon-
ser afisinden cikolata tanitim afisine kadar
uzanan genis bir yelpazeye sahiptir. Buna
ragmen mesaj ve igerik agisindan afigler;
reklam afigleri, kalturel afigler, sosyal afigler
olmak Gzere Uc¢ grupta toplanmistir.

Reklam Afigleri

Bir Urin ya da hizmeti halka tanitmay1 amacg-
layan afiglerdir. Halki bilgilendirmek ve yon-
lendirmek icin kullanilirlar. Tasarimi yapilan
firma ya da urane goére cesitlilik gosterirler
(Gorsel 2.2).
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— DONDURMA
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- = lcRET:
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INTERNET ADRESI/ SOSYAL MEDYA HESAPLARI/SPONSOR FIRMALAR
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b) Gezi afisi ¢) Uriin afisi
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Kultarel Afigler

Herhangi bir klttrel etkinlik veya Grin ile
ilgili olan tasarimlar kdlttrel afis kapsami-
na girer. Sanat ve kdlturle ilgili olan afigler-
dir. Konulari; sanat galerileri, klttirel olay-
lar, sergi, film, tiyatro, festival, mizik, spor,
kitap, sinema, konser gibi (Gdrsel 2.3).

44

Kaybolan Yesil
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YER: UCRET: ILETISIM TEL:

b) Tiyatro afigi
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DUnya Emekci
Kadwilar GOnG

Gorsel 2.4: a) Kadinlar GUnu afisi

b) “Cevre” konulu afisi

AFIS TASARIMFe

Sosyal Afigler

Toplumda farkindalik yaratmak, insan-
larin bazi konulara daha duyarli yaklas-
malarini saglamak, toplum duizenini ko-
rumak gibi amaclara yénelik hazirlanan
afisler, sosyal afiglerdir (Goérsel 2.4).
Cevre, egitim, politika, saglk gibi konu
basliklari vardir.
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2.1.2. Afis Tasariminda Dikkat
Edilecek Hususlar

Tasarimin her alaninda oldugu gibi afis ta-
sarimi yaparken de tasarimcinin musteri ile
fikir aligverisi yapip konu ile ilgili énceligi be-
lirlemesi gerekir. Afisin amaci nedir? Bir Grin
mu yoksa hizmet mi tanitilacak (Goérsel 2.5).
Hedef kitlesi kimdir? Hangi sosyal kesime
hitap edecek? Hedef kitlenin yas araligi ne-
dir? Sosyal icerikli bir afis mi olacak? Politik
bir afis mi olacak? Tasarimci bu tarz sorular
sormall ve tasarimina bu sorularin cevaplari
dogrultusunda baglamalidir.

&

o

TASARIM

DTACarace
Sachet do Panlens
Samd Snialage
=

Connalle . Orange
A, > -
[T

b) Tanitim afisi
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Tasarimin amaci, hedef kitlesi vb. belirlendikten sonra afisin sergilenecegi alan incelenmeli
ve baskida kullanilacak malzeme ona goére secilmelidir. Afigler kullanilacagi alana gore i¢
mekéan ve dis mekan olarak ikiye ayrilir, bu ayrim afislerin tasariminda kullanilacak égeleri
(tipografi, gorsel vb.) etkiler. ic mekan afislerini inceleme siresi, dis mekan afislerine gére
daha uzundur. insanlar dis mekan afiglerini incelemek igin uzun bir zaman ayiramadik-
larindan dis mekan afisleri, mesaji en hizli sekilde iletmek zorundadir. Tasarimcilar, afis
tasarimi yaparken bu kriteri g6z éntinde bulundurmahdir.

Tasarim yapilirken Griin, hizmet ya da firmanin yeni olup olmadig: dikkate alinmalidir.
Taninmig bir firmayla taninmayan bir firmanin Grlin tanitim afisi ayni tasarim dizenine sa-
hip olamaz. Taninmig bir firmanin tasariminda trtin 6n planda iken taninmamis bir firmanin
tasariminda firma 6n plana alinir.

insanlarin dikkatini hemen gekecek bir slogan kullaniimahdir. Ozellikle dis mekanda sergi-
lenecek afiglerin mesaji iletme suresi cok kisadir. Slogan secimi Urlnl daha ¢arpici héle
getirir.

Afig tasariminin boyutlari, afisin ic mekan ve dig mekan kullanimina gére secilmelidir. Dis mekéan-
da yazi ve gdrsellerin daha gérulebilir, okunabilir olmasi ve mesajin ¢cabuk fark edilmesi icin blyuk
boyutlar tercih edilirken ic mekanda daha standart boyutlar kullanilabilir. Afis icin secilen boyutlari
kullanim alanina gére degisiklik gésterse de genelde 35 x 50 cm, 50 x 70 cm, 70 x 100 cm tercih
edilir. Ayrica afigler, kullanildiklari yerlere ve él¢llerine goére farkli isimler alir (Gorsel 2.6).

AFIS TA@A@IMre

Raket (CLP)
Olctiler
118,5x 175 cm

|
Totem
Olctiler
I 624 x 447 cm

Megalight Billboard
Olciiler Olctiler
323x241 cm 350x 200 cm

Gérsel 2.6: Dis mekan reklam panolari
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Afis tasarimi yapilirken kullanilacak renkler de dikkatlice segilmelidir. Urlin, hizmet ya da
mesaja uygun renkler kullaniimali ve renklerin insanlar Gzerindeki psikolojik etkileri g6z
Onunde tutulmalidir.

Yapilan tasarimda mesaj, Urtin ya da hizmet merkeze alinmali; dikkati dagitacak baska ma-
teryaller kullaniimamalidir. Tasarimin sadeligi algilama hizini olumlu etkiler. Vurgulanmak
istenenler daha ¢abuk algilanir (Goérsel 2.7).

Tasarimda kullanilacak tipografik dgeler yine afisin mesajina, hedef kitlesine ve amacina
uygun olmahdir. Yazi puntosu, afisin kullanilacagi mekéna gére secilmeli; algiy! zorlas-
tiracak fontlardan kaciniimalidir. Afiste verilecek mesaj yalin bir dille anlatiimalidir. Afis
tasarimi yapilirken ¢ok cesitli tasarim elemanlarindan faydalanilabilir. Tipografi, fotograf,
illustrasyon ya da farkh ¢izim teknikleri kullanilabilir.

Gorsel 2.7: Sosyal afis
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2.1.3. Afis Eskizi Hazirlama

Tasarimi yapilacak afisin icerigi, hedef kitlesi,

sergilenecegdi alan ve afisle verilmek istenen
mesaj dogrultusunda eskiz hazirlama calisma-
larina baslanir. Bu calismalarda dikkat edilme-
si gereken édnemli noktalar vardir.

® Calisma yapilirken kullanilacak malze-
melerin ve calisma ortaminin temizligi-
ne dikkat edilmelidir.

* Afisi yapilacak urin, firma ya da etkin-
ligin icerigi ile ilgili arastirma yapilmali;
bunlarin hangi alanda faaliyet yuratta-
gu, hangi hedef kitleye hitap ettigi belir-
lenmeli ve sonrasinda tasarim kismina

gecilmelidir.

® Yapilanarastirmasonucundahazirlana- .
Sponsor firmalar / Tel / Adres

cak afise uygun slogan belirlenmelidir.

* Afisin 06lcusu, kullanilacagi ic ve dis

mekéna gore ayarlanmalidir. Tasarimda Gorsel 2.8: Afis eskizi
kullanilacak tipografik unsurlar buna
gobre ayarlanmalidir.

e Afiste kullanilacak gdrsel materyaller
belirlenmelidir.

* Afiste kullanilacak gorsel, yazi, slogan
vs.nin yerlesimi bos bir A4’e genel hat-
lariyla gizilmelidir (Gérsel 2.8).

® Eskiz ciziminden sonra calisma alani
temizlenmelidir.

® Yapilan eskiz bir dosyada saklanmalidir.

®* Tasarimda kullanacak go6rsel mater-
yallerin orijinalleri hazirlanmalidir. Bu
materyalleri tasarimci olusturmalidir.
intiyac halinde fotografi tasarimci kendi
cekmelidir.

* Materyaller (yazi, fotograf, vektorel ¢i-
zim vb.) bilgisayar ortaminda olusturu-
lacak bir klasérde toplanmalidir.

anttim Grafigi
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. Efkinlik

Gorsel 2.9’daki afis tasarimini inceleyerek afisin dikkat ceken yénleri-
ni asagidaki bosluklara yaziniz. Yazdiklarinizi sinifta arkadaslarinizla

tartisiniz.

Eq kehramen TURK KADIN,
sen yerde sirinmeye deGil
amuzlur Uzerinde giklore
YUKSELMEYE LAYIKSIN.

anttim Grafigi
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2. Efinlik
7

Gorsel 2.10’u inceleyiniz. Gorseldeki tasarim 6gelerini kullanarak Sekil
2.71’in icine farkh bir afis tasarimi eskizi ciziniz.

SOIO RENAN

Gorsel 2.10: Konser afisi

Sekil 2.1 J
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Afis Tasarnim Ornekleri

" . . »
INSAN KENDi SONUNDA BOGULDU
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Gorsel 2.12

(9]
w

%]’mmﬂm grafigi




3‘»&1@ TASARM

"ATIK PILLER GER'

DONUSTURULEBILIR
AMA DOGA

Gorsel 2.13

ajmmﬂm grafigi
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Gorsel 2.15
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Gorsel 2.16
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Gorsel 2.17
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OGRENME BIRIMi: AFiS TASARIMI
UYGULAMA ADI : Afig Tasarim Eskizleri Hazirlama

AMAC

: Afig tasarim eskizleri hazirlamak.

Arac Gerec

1.
2.
3.
4.

Gorsel

A4 parsémen kagidi
2H resim kalemi
Silgi

Cetvel

2.19'u inceleyiniz. Siz de sectiginiz bir konuda afis tasarim eskizini asagi-

daki islem basamaklarini dikkate alarak yapiniz.

islem
1.

2.

3.

4.

Logo

Gorsel alani

Adres / Tel / Sosyal medya hesaplar vb.

Gorsel 2.19: Afis eskizi

Basamaklari

Atdlye 6nllguniza giyiniz; arag gerecinizi, calisma alaninizi is saghgi ve given-
ligi tedbirlerini alarak 6zenle hazirlayiniz.

Eskizini yapacaginiz konu hakkinda arastirma yapip daha énceden yapilan afig
tasarimlarini inceleyiniz.

A4 kagidina afig tasarim eskizini Gorsel 2.19°daki gibi yapiniz. Cizim yaparken
kullaniimis k&gitlarin ya da ise yaramayan eski belgelerin arkalarini kullanabilir,
bdylelikle israftan kacinmis olursunuz.

Calisma ortamini arkadaslarinizla birlikte temizleyip ¢alismanizi 6gretmeninize

teslim ediniz.

Degerlendirme

Uygulama calismanizin siresi 6gretmeniniz tarafindan belirlenecektir. Calismaniz,
1. Ek’te verilen “Degerlendirme Formu” veya “Kontrol Listesi’ndeki ol¢ltlere gore
degerlendirilecektir. Calismanizi yaparken bu 6lgitleri dikkate aliniz.
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2.2. BASKALASTIRMA (MANIPULASYON)

Baskalastirma, TDK’ye gére bir kitlenin fiziki ve kimyasal 6zelliklerinin degismesi anlamina
gelmektedir. Manipllasyon ise Turkgceye Fransizcadan girmistir. Segme, ekleme ve cikar-
ma yoluyla bilgileri degistirme, yénlendirme anlamlarini icermektedir.

Grafik sanatlarda bagkalasim (manipulasyon) bir fotograf Gzerinde yapilan en ki¢ik degi-
sikligi bile kapsamaktadir. Orijinal olana her midahale baskalagsimi dogurur. Baskalasim,
bir fotograf Gzerinde yapilabilecegi gibi farkl birka¢ fotografin birlestiriimesiyle de olabilir.
Grafik tasarimcilar; baskalasimi daha 6zgun fikirler ortaya ¢ikarmak, siradanliktan uzak-
lasmak ve hedef kitlenin dikkatini cekmek igin siklikla kullanir.

Baskalastirma Yapilirken Kullanilan Araclar

Baskalasim yapilirken piksel tabanli programlar tercih edilir. Bu programlarda bulunan
doku, renk, filtre, déndirme ve donustirme, maskeleme ve bazi temel rétus araclar kulla-
nilir. Baskalasim yapilirken Image > Adjustments yoluyla renk, kontrast vb. ayarlara ula-
silabilir (Gorsel 2.20). Ayrica program menu ¢gubugunda bulunan Filter sekmesinden ¢esitli
hazir filtrelere; Tools’dan doku, rétus araclarina ulasilabilir.

Baskalasim yapilirken kullanilacak fotograflarda 1sik uyumlari, perspektif uyumlari, doku
uyumlari, piksel ve ¢6zUnurlik uyumlari birbirlerine denk olmalidir. Ortaya ¢ikan yeni Gru-
nin kalitesi ve basarisi fotograflarin uyumuna baglhdir. Baskalasim yapilirken dikkat edil-
mesi gereken belli basli kurallar vardir.

* Kullanilacak fotograflarda dekupe islemi titizlikle yapiimalidir.

® Gergekgei bir gérinum icin gercekgi 1sik ve gblge kullaniimalidir.

* Kullanilacak fotograflarin dokularina, perspektifine, oran ve renk uyumlarina dik-

kat edilmelidir.

Image Select  Filker  Wiew  Window

kode

Layer  Type

Adjustments 4

Auta Tone
Auta Contrast
Auto Color

Shift+Ctrl+L
Alt+Shift+Ctrl+L
Shift+Ctrl +B

Chrl+L
Ctrl+M

Lewvels...
Cunves.,

Exposure...

Alt+Ctrl +]
Alt+Ctrl+C

Irage Rotation L4

Image Size...
Canwas Size..,

Wikrance..,
Ctrl+U
Ctrl+B

Hue/Saturation...
Color Balance...

Black & White, . Alt+Shift+Ctrl+B
Crop i

Phota Filter...
s Channel Mi

annel Mixer..,

Reveal All

Calor Lookup..,
Duplicate..,

Irrvert Ctrl+]
Apply Image..,

Calculations..,

Wariables ¥
Apply Data Set.,

Posterize..,
Threshold..,
Gradient Map..,
Selective Color.,

Trap..

Analysis

Shadows/Highlights..,
HDR Toning..,
Wariations...

Desaturate Shift+Ctrl+1)
Match Color,.,
Replace Colar...

Equalize

Gorsel 2.20: Adjustments paneli
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2.2.1. Bagkalastirma (Manipulasyon) Yontemleri

Baskalasim yapilirken renk ve dokuya muidahale edildigi gibi biyultme, kig¢lltme vb. ayar-
lar da yapilir. Piksel tabanh gérintl isleme programinin sagladigi olanaklar kullanilir.
Baskalasim yapilirken kullanilan belli basl yéntemler vardir.

Boyutlandirma ve Déniistiirme islemleri: Fotograflarin boyutlari ve perspektif ayarlari
yapilirken kullanilan bir yéntemdir (Gorsel 2.21).

Dokuya Miidahale Etme: Doku tasima, yeni doku olus-
turma gibi islemlerle fotografa fantastik bir gérinim ka-
zandirilabilir (Gorsel 2.22).

Renge Miidahale Etme: Fotograflarin tonlarini esitlemek,
renklerini degistirmek gibi islemlerle baskalagsim daha
gercekci ya da daha fantastik hale getirilir (Gorsel 2.23).

Auto Tone
Hato Contrast Alt+ShifteCtrl+L
Auto Color Shift+Ctrl«B

Irnage Size.. AdtsCtrlsl
Camvas Size... AlesCirl+C
Ierage Rotation L o

::::::

Crop
Reves| Al
= ? e Color Loakup...
1 & 1 ConesmpTod S # Duplicate... Twart Culsl |
_\_1_ Pattern Starrp Tod 5 | N Cnll ’M_“g'“' Posterize...
: . culona:: Theeshald...
Variables b Gradient Map..
Apohy Data Sat. Selective Color.—.

.| HDR Toning...
Variations..

Desaturate Shift s Ctrl+ L)
Mateh Color...
Replace Color...

Gorsel 2.22: Dokuya midahale Gorsel 2.23: Renk degistirme

62



AFIS TASARIM

Filtrelerle Miidahale: Fotograflara programda bulunan hazir filtre efektlerini uygulamaktir.
Fotografta farkli atmosfer yaratmaya yardimci olur (Gorsel 2.24).

A | e Gl s e I | ok |

e 2 Y e

b et Chal & Chasnd aes celsas

“ condliba S Lerder Ihiiress
. >

Cheire Conre Crapsn. Arnphi By

|ﬁ' <

'u| [T

Leht Intevmly.
A

|
s A 3
] e e

Vlhanm Gutmm Hiate Fapar Fhotoeopy

=

] Toen [dger i Pt

e
= o

Cavasis Al Manee Tie

I I S v Fwhaat

Gorsel 2.24: Efekt verme

Maskeleme: Fotograflarin ¢calisma agisindan gereksiz olan alanlari maskelenir, bu alanla-
rin gérinmemesi saglanir (Goérsel 2.25).

Propertles

3 Masks

20210606_155348 jpg ©@ 25% (Layer 0. Layer Mask/#) *

Feather:

>
&
S
—
S
=
=
c
S

Gorsel 2.25: Maskeleme

63




3‘»&1@ TASARM

%. Etkinlik

Belirlediginiz bir hayvan fotografinda hayvanin géz rengini degistiri-
niz. Yaptiginiz calismanin c¢iktisini alip 6gretmeninizle ve arkadaslari-
nizla paylasiniz.

¢. Etkinlik
Belirlediginiz bir manzara fotografinda istediginiz bir nesnenin doku-
sunu degistiriniz. Yaptiginiz calismanin ciktisini alip 6gretmeninizie ve
arkadaslarinizla paylasiniz.

2.2.2. Baskalastirma (Manipiilasyon) Ornekleri

=
&
N
—
S
=
=
<
S

Gorsel 2.26
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b) Hikmet Aysel manUpilasyon calismasi
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Gorsel 2.29: Hikmet Aysel manUpilasyon ¢alismasi
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Gérsel 2.30: Hikmet Aysel manUpilasyon calismasi
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Gorsel 2.31: Hikmet Aysel manUpilasyon calismasi
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Gorsel 2.32

Gorsel 2.33

Gorsel 2.34
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Gorsel 2.35

Gorsel 2.37

Gorsel 2.36
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Gorsel 2.38
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Gorsel 2.39

Gorsel 2.40

anttim Grafigl

Gorsel 2.41
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Baskalastirma Yoéntemi ile Afis Ornekleri

sosyé*
medya
ete
kemige
biiriindii

450

indirim

Gorsel 2.42: Hikmet Aysel manUpilasyon afis calismasi
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Gorsel 2.43: Hikmet Aysel manUpilasyon afis calismasi
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OGRENME BIRIMi: AFIS TASARIMI

S UYGULAMA ADI : Pixel Tabanli Programda Baskalastirma (Manipulasyon)
E Yapma
_S_ AMAC : Pixel tabanli programda baskalastirma (manipllasyon)
% yapmak.
5; Arac Gerecg
. 1. lIslem yapilacak gérsel
N 2. Bilgisayar
3. Goruantl dizenleme
programi

Gorsel 2.44’teki calismayi inceleyiniz. Siz de sectiginiz bir gorsel lizerinde
asagidaki islem basamaklarini dikkate alarak baskalasim calismasi yapiniz.

Gorsel 2.44: Bagkalastirma 6rnegi

islem Basamaklari

1. Atélye 6nluganizu giyiniz; ara¢ gerecinizi, ¢calisma alaninizi is saghgi ve
guvenligi tedbirlerini alarak 6zenle hazirlayiniz.

2. Bagkalasim yapacaginiz konu hakkinda arastirma yapip daha énceden
yapilan bagkalasim tasarimlarini inceleyiniz.

3. Bagkalasim yapacaginiz gesitli gorseller bulunuz.

4. Baskalasim yapacaginiz gorseli acip, istediginiz degisiklikleri yaparak ca-
lismanizi bitiriniz.

5. Calismanizi piksel tabanh program formatinda (PSD) ve baskiya uygun
formatta (TIFF / JPG) kaydediniz.

6. Calismanizi harici bellege kaydediniz.

7. lsiniz bittiginde ¢alismanizin ¢iktisini alarak égretmeniniz ve arkadaslari-
nizla paylasiniz.

8. Bilgisayarinizi kapatiniz. Calisma ortaminizi arkadaslarinizla temizleyip
duzenleyiniz.

Degerlendirme

Uygulama calismanizin slresi 6gretmeniniz tarafindan belirlenecektir. Calismaniz,
1. Ek’te verilen “Degerlendirme Formu” veya “Kontrol Listesi’ndeki 6lcutlere gére
degerlendirilecektir. Calismanizi yaparken bu élgutleri dikkate aliniz.

anttim Grafigi
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2.3. BILGISAYARDA AFiS OLUSTURMA

Yapilan her tasarimda oldugu gibi afis tasariminda da
ilk asama eskiz yapmaktir. Yapilan eskizlerden en
uygun olan secilerek gerekli materyaller bilgisayarda
olusturulan bir klasérde toplanir. Calisma yapilirken
calisilacak konuya ve yapilacak isleme gére hem vek-
tér tabanh hem de piksel tabanl program kullanilir.

Afis tasarimina baslanirken dncelikle ¢alisma icin se-
cilen eskiz dogrultusunda piksel tabanli program agil-
malidir. File > New (Ctrl+N) ile afisin dl¢isine gbre
calisma sayfasi acilir. File > Place ile calisma sayfa-
sina islem yapilacak fotograf aktarilir (Gorsel 2.45).

mnlpsd @ 33.3% (Layer 2, RGB/8) * x IMG20210716172944 (1).jpg

-

AT
\q._‘. )+

Gorsel 2.46: Afis yapim asamasi

Afis calismasinda kullanilacak fontlar, yine calismanin
icerigine gore secilip yerlestirilir. Afis calismalarinda
fazla font ¢esidi kullanilmamal, yazilarin okunakli ol-
masina 6zen gosterilmelidir (Gorsel 2.47).

74

New... Ctrl+N
Open... Ctrl+0
Browse in Bridge... AaCtrl+O
Browse in Mini Bridge...
Open As..,

Open a5 Smart Object...
Open Recent

Close Ctrl+W
Close All Alt+Ctrd +W
Close and Go to Bridge... Shift+Ctrl + W
Save Ctrl+5
Save As.., Shift+Ctrl+5
Check In...

Save for Web... Alt+Shift+Ctrl+5
Revert F12

Place... ¥
g

Import
Export

Alt+Shift+Ctrl + 0

Autornate
Scripts
File Info...

L3
13
13
L3

Alt+Shift+ Ctrl+|

Print... Ctrl+P
Print One Copy Alts+ShiftsCtrl +P

Exit Curl+Q

Gorsel 2.45: Calisma sayfasina fotograf
cagirma

Calismada bagkalasim ic¢in kullani-
lacak alanlar, diger fotograflardan
temizlenerek ana calisma sayfasina
getirilir (Gorsel 2.46). Kullanilacak
tim gorsel parcalari ayni c¢alisma
sayfasina alindiktan sonra isik, renk,
perspektif vb. ayarlar yapilarak bas-
kalagim tamamlanir.

Gorsel 2.47: Font secimi
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Yaziya istenen efektler verilir, dizenlemeler yapilir. Sonra diger yazilar (adres, tarih vb.), kullani-
lacak logolar yerlerine yerlestirilerek ¢calisma sonlandirilir (Gérsel 2.48).

Yapilan afis calismasi son halini aldik-
tan sonra baski ayarlari yapilir ve baski
formatinda kaydedilir (Gorsel 2.49). Son
anda olusabilecek degisiklikler icin calis-
manin orijinal dosyasi saklanmalidir.

2
&
S
—
S
=
B
<
S

Gorsel 2.49: Cocuk tiyatrosu afisi
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OGRENME BIRIMi: AFiS TASARIMI
UYGULAMA ADI : Bilgisayarda Afis Yapma
AMAC : Bilgisayarda afis yapmak.

Arac Gerec

1. A4 parsébmen kagidi
2. 2H resim kalemi

3. Silgi

4. Cetvel

5. Bilgisayar

6. Goruntd dizenleme programi

2. lAygulaman

Gorsel 2.50°deki calismayi inceleyiniz. Siz de seg¢tiginiz bir konuda asagidaki
islem basamaklarini dikkate alarak afis calismasi yapiniz.

;“

Gk i, - e

Gorsel 2.50: Reklam afisi

islem Basamaklari

1. Atdlye 6nligunuzl giyiniz; ara¢ gerecinizi, calisma alaninizi is saghg ve
guvenligi tedbirlerini alarak 6zenle hazirlayiniz.

2. Afis yapacaginiz konu hakkinda arastirma yapip daha énceden yapilan afis
tasarimlarini inceleyiniz.

3. Farkh eskizler yapiniz. Uygun olan eskizi secip ¢calismaya baslayiniz.

4. Calisma yapacaginiz piksel ya da vektér tabanli programi aginiz.

5. Afis icin sectiginiz eskize gbre ¢alismanizi bilgisayar ortaminda yapiniz.

6. Calismanizi piksel tabanl program formatinda (PSD) ve baskiya uygun
formatta (TIFF / JPG) kaydediniz.

7. Calismanizin c¢iktisini alip 63retmeninize teslim ediniz.

8. Calisma ortamini arkadaslarinizla birlikte temizleyiniz.

Degerlendirme

Uygulama calismanizin siresi 6gretmeniniz tarafindan belirlenecektir. Calismaniz,
1. Ek’te verilen “Degerlendirme Formu” veya “Kontrol Listesi’ndeki dl¢itlere gore
degerlendirilecektir. Calismanizi yaparken bu élgutleri dikkate aliniz.

anttim Grafigl
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OLCME VE DEGERLENDIRME

A)

B)

C)

D)

Asagida verilen ciimlelerin basindaki parantezlere ciimleler dogru ise “D”, yanls ise
“Y” yaziniz.

1. () Afigler, bilgi vermeyi ve buyuk kitlelere tanitim yapmayi amaclayan calismalardir.
2. () Afiglerde sadece tipografik unsurlar kullaniimalidir.

3. () Afig tasarimi icin hedef kitlenin &zellikleri dikkate alinmaz.

4. () Afiglerde farkh 6lguler kullaniimaktadir.

5. () Afigler sadece piksel tabanh programlarda hazirlanir.

Asagida verilen ciimlelerde yer alan bosluklari uygun ifadelerle doldurunuz.

6. Basgkalasim ..............ooin programlarinda yapillir.

7. Afiglerde ........ocoiiiiiiiinn. mekéana gore degisir.

8. Uriin ya da hizmeti tanitmay1 amaglayan afiglere........................... denir.

9. Afig tasarimini bilgisayar ortamina aktarmadan énce ........................... yapiimahdir.
10. Afig tasarimlarinda konuya goére farkl ................ooooieene. kullanilabilir.

Asagida verilen sorularin dogru cevaplarini isaretleyiniz.

11. Asagidakilerden hangisi baskalasim yéntemlerinden degildir?
A) Boyutlandirma
B) Doku
C) Filtre
D) Isik
E) Maskeleme
12. Manipulasyon uygulamasini agiklayan terim asagidakilerden hangisidir?
A) Bagkalastirma
B) Degistirme
C) Duzenleme
D) Kesme
E) Kopyalama

Asagida verilen sorularin cevaplarini noktali yerlere yaziniz.

13. Sosyal afis tasarimi ile reklam afis tasarimi arasindaki farklar nelerdir? Kisaca agiklayiniz.

anttim Grafigi
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OGRENME
® BiRIMI

TIKET
TASARIMI

KONULAR

. 3.1. ETIKET TASARIMI ESKizi
~ . - -
oY 3.2. BILGISAYARDA ETIKET OLUSTURMA
N
N - o . .
\\ NELER OGRENECEKSINIZ?
,’ » Etiketin tanimi, cesitleri ve etiket tasariminda dikkat
,’ edilmesi gereken hususlar
,/ « Uriin 6zelligine gore etiket tasarimi icin eskiz ca-
/ ligsmasi yapma
/ * Belirlenen etiket eskizini sayisal (dijital) ortama ak-
,’ tararak istenen sirede baskiya hazirlama
TEMEL KAVRAMLAR
* eskiz
* renk

* baski teknikleri

HAZIRLIK CALISMALARI

1. Etiket denince akliniza neler geliyor? Tartisiniz.
2. Sizce etiketin kullanim amaci nedir? Dislincelerinizi
arkadaslarinizla paylasiniz.



Tanitim Grafidi

ETKET TASARM

3.1. ETIKET TASARIMI ESKizi

Etiket; ait oldugu Urindn fiyati, Uretim ve son
kullanim tarihi, kullanim kosullari, firma ileti-
sim bilgileri, firmanin logosu gibi bircok bilginin
oldugu basili bir materyaldir. Birbirinden farkli
alanlara sahip olan etiketlerin glinimuzdeki en
Onemli gbrevi, market raflarinda masteri bekle-
yen Urlnlerin rakip firmalardan ayrilarak dikkat
cekmesini saglamaktir. Urlin tanitiminda olduk-
c¢a etkili bir ara¢ olan etiketlerin ayni zamanda
marka degerini artirma yoénlinde de bir etkisi
vardir. Her sektdriin kendine ait etiket tasarimi
vardir.

Kullanim alanlarina gére ginimuzde en ¢ok
tercih edilen etiket turleri; Grtn etiketleri, yi-
kama talimatlari, fiyat etiketleri, marka eti-
ketleri, uyari etiketleri ve barkod etiketlerdir.

LI@L Kutueu

Uriin veya hizmetin hedef kitleye
istenen sekilde ulastirimasini sag-
layan en 6nemli sure¢ tanitim ve
reklamdir.

=

§ = airtlen regeli |

‘0,0ur
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Gorsel 3.1: Z. Melike Keskus etiket 6rnekleri
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Uriin Etiketleri: Uriinin kullanim bicimi- Yikama Etiketleri: Tekstil Griinlerinde rast-
ni, 6zelliklerini, agirligini, Gretim amacini, lanilan bu etiketler, Grtnlerin yipranmadan
markasini gésteren ve tuketiciyi bilgilen- dogru bir sekilde nasil yikanmasi gerektigi
dirmek amaciyla uretilmis etiket tiridir konusunda detayl bilgiler veren etiket tartdar

(Gorsel 3.2). (Gorsel 3.3).

YIKAMA TALIMATI

WAXACKE

Benzer renklerlerie birlikte tersten yikayinz.
Wash inside out with similar colours.

Made in Tarkiye

Gorsel 3.2: Uriin etiketi | Gorsel 3.3: Yikama etiketi

Fiyat Etiketleri: Bir Grinin miktari, tiri, Marka Etiketleri: Ur(in ya da ambalajin ize-
fiyati gibi bilgilerin oldugu etiket tirtdir rine konulan ve markayi ortaya ¢ikaran etiket
(Gorsel 3.4). taridir (Gorsel 3.5).

Gorsel 3.4: Fiyat etiketi —— L Gorsel 3.5: Marka etiketi

anttim grafigi
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Uyari Etiketleri: Tuketicilerin ve kullanicilarin tehlikeli madde ve Urlnlere kargi korunmasi
icin hazirlanmis etiket tarudur (Gorsel 3.6).

(DIKKAT !] (A

Traktor Kuyruk Mili Koruyucu Muhafaxays Makineyi Ayarlarh ve Altina
Dovrinin 540 d/dak. Takmadan Makineyi veo Yaglarken Troktord Elinizi vo Ayaginizi Makine Gahgirken
C)lmnmm Dikkat ldan b Caligtirmayin ) \ Stop Edin y L Uzatmayin ! \ Uzakta Durun )

(@ €]
*o | m-T

Dénon Tamburlann

Gorsel 3.6: Uyar etiketi

Barkod Etiketler: Uriinlerin Gizerine yapistirilan ve barkod sistemi olan etiket tiradir
(Gorsel 3.7).

Gorsel 3.7: Barkod etiket

Urlin ve marka etiket tasarimi yapilirken dikkat edilmesi gereken bazi hususlar vardir.

82

Markanin logosu dikkat cekecek bir sekilde kullaniimalidir.

Yapilacak etiket, urinin temel bilgilerini ve d6zelliklerini yansitmalidir; yazilar agik
ve okunabilir olmahdir.

Kullanilan goérseller ilk izlenimde dikkat cekmeli ve bilgilendirici olmahdir.

Tasarim Uzerinde kullanilan renkler dikkat cekmelidir.

Secilen yazi tipi tasarimla uyumlu olmalidir.

Uriin hakkinda verilen énemli bilgiler en Uste bilyiik puntolarla yazilmali, diger bil-
giler ise uygun puntolarla siralanmalidir.

Yeterli oranda beyaz alan birakilmalidir.

Firmaya ait iletisim bilgileri agik ve net olmalidir.
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|. Etkinlk

Gorsel 3.8’i inceleyiniz. Siz de sectiginiz bir Uriin icin etiket eskizini 7

Sekil 3.1’in icine ciziniz.

\_

Gorsel 3.8: Etiket eskiz drnekleri

Sekil 3.1

83
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3.1.1. Etiket Cesitleri
Etiket cesitleri kendi arasinda kagit bazh etiketler ve plastik bazl etiketler olmak Uzere ikiye
ayrilir (Gorsel 3.9).

—
ﬁHI

NATURAL

DENTIST

MEALTHY Ly
[m ¥

Gorsel 3.9: Kagit bazli ve plastik bazl etiketler

Kagit Bazli Etiketler
Kagit bazli etiketlerin Gretiminde k&gt ve tirevi malzemeler kullanilir. Kagit bazl etiketler, kuse ve
termal olarak Uretilir (Gorsel 3.10).

Gorsel 3.10: K&git bazli etiket dérnekleri
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Kuse etiket: Ust kismi parlak ve piiriizsiiz olan kuse etiket, kagit bazl oldugu icin yeteri kadar
dayanikl degildir. Isi, surtinme ve neme kargi dayanikliligi orta seviyededir.

Fastyre (festyir) etiket: Fiziksel yapisi nedeniyle bir tarafi metalik yapiskandir. Kagit bazh etiket
sinifinda yer alan fastyre etiket, genellikle tekstil sektériinde kullanilir.

Eco (eko) termal etiket: Uzun dmdarli bir etiket tira degildir. Bu etiket tirindn raf émra genellikle
3-6 ay arasidir. Bu etiketlerin ylzeyinde koruyucu bir tabaka bulunmaz. Eco termal etiketler, nemli
ve sicak ortamlarda kullaniimaz.

Lamine termal etiket: Lamine etiketin tzerinde koruyucu tabaka bulunur. Kullanim émrl 6-9 ay
olan bu etiketler, eco termal etikete oranla daha dayaniklidir.

Vellum (velim) etiket: Kuse etiket ile birbirine benzetilir. iki etiket tiiriiniin arasindaki fark, vellum
etikette gozle gdrulemeyen gbzeneklerin bulunmasidir.

Termal etiket: Bu etiketler icin dogrudan termal baski yéntemi kullanilabilir ve etiket baskisi ali-
nabilir. Termal etiket ayni zamanda maliyeti dusuk etiket cesitlerindendir.

Floresan etiket: Bu etiket turl suya ve neme kargi dayanikli degildir. Bu nedenle kolaylikla yirti-
labilir. Floresan etiketler sari, kirmizi, turuncu, mavi ve yesil renkte Uretilebilir.

Gorsel 3.11: Etiket cesitleri
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Plastik Bazli Etiketler

Plastik bazli etiketlerin dayaniklihgi k&git bazh etiketlere oranla daha fazladir. Dayanikh olmalarin-
dan dolayi genellikle sanayi, kozmetik ve kimya sektérinde kullanilirlar.

s A

ELaC]

- SidNvTIo)

Gorsel 3.12: Plastik bazli etiket 6rnekleri

Lazer yazici etiket: Bu etiket tir( diger tlrlere oranla oldukga dayanikhidir. Lazer yazici ile basi-
lan etiketlerin daha uzun 6murli ve daha dayanikli oldugu bilinir. Lazer yazici etiket icin kullanilan
kagitlar silinmezlik garantisi vermektedir. Barkod yazici etiket ¢esitlerinden biri olarak kullanilir.
Sleeve (sliliv) etiket: Bu etiket tlr(, ambalaji tamamen sardidi i¢in diger bir isimle “cepecevre
saran etiket” olarak da bilinir. Ambalajin etrafini 360° ¢cepecgevre saran etiketlerdir. Ambalajlarin
dekorlanmasindan Griin guvenligine kadar bircok dnemli etkinlige sahiptir (Gérsel 3.13).

Gorsel 3.13: Sleeve etiket 6rnegi
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Kirilgan etiket (glivenlik etiketi): Guvenlik etiketi olarak kullanilan kirilgan etiketler, herhangi bir
kuvvet uygulandiginda kirilarak dagilir. Bu etiket ayni zamanda garanti etiketi olarak da kabul edi-
lebilir. Teknolojik Urtinlerin Uzerinde kullanilan kirllgan givenlik etiketi sayesinde Urlnlerin tamir
garantileri takip edilir. Genellikle bilgisayar kasalari ve malzemelerine teknik destek veren firmalar
tarafindan kullanilir (Gorsel 3.14).

0P

Gorsel 3.14: Kirilgan etiket (glvenlik etiketi)

Seffaf etiket: Bu etiketlerde etiketin ylzeyi ve zemini gérinir. Isi, 1sIk ve neme karsi dayanikh
olan seffaf etiketler farkli alanlarda kullanilabilir. Seffaf oldugu icin baski makinesinde gérinme-
yen bu etiketler igin 6ncelikle kilavuz baskisi yapiimalidir (Gérsel 3.15).

Silvermat (silvirmet) etiket: Bu etiketlerin iki ylizeyi mat ya da parlak gri renktedir. Hem 1siya
hem de sogugda karsi dayanikhidir. Yapiskanli 6zel bir yapiya sahip olan bu etiketler uzun émdr-
ladar.

Filmictyre (filmiktayir) etiket: Sert malzemelerden yapilmigtir. Zorlanma olmadigdi strece yirtil-
mayan ve yapisini koruyan etiket taraddir.

Gorsel 3.15: Seffaf etiket drnekleri
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OGRENME BIiRiMi: ETIKET TASARIMI
UYGULAMA ADI : Uriin Etiketi Eskizi Yapma

AMAC : Etiket eskiz calismalari yapmak.
Arac Gerec
1. Resim kagidi
2. Kursun kalem, silgi, ¢izim arac gerecleri (cetvel, sekil sablonu vb.)
3. Boya malzemeleri
4. Bant, makas

Asagidaki islem basamaklarini dikkate alarak etiket tasarimi eskizi giziniz.

islem Basamaklar

1.

A

8.

Atblye 6nlugunizl giyiniz; arag gerecinizi, calisma alaninizi is saghgi
ve glvenligi tedbirlerini alarak 6zenle hazirlayiniz.

Konunun icerigine uygun bir sektdr belirleyiniz.

Belirlediginiz sektdre ait etiket drneklerini inceleyiniz.

Eskiz yapilacak kagidi ¢izim masasina sabitleyiniz.

Kompozisyon kurallarina uyarak kara kalem ve boyama teknikleriyle
eskizinizi olusturunuz.

Calisirken oturma pozisyonunuza dikkat ediniz, yanlis oturus sekli sag-
hginiz icin zararhdir.

Calismanizi tamamladiktan sonra ¢alismanizi égretmeninize teslim
ediniz.

Iisiniz bittikten sonra galisma alaninizi temizleyiniz.

Degerlendirme

Uygulama calismanizin siresi 6gretmeniniz tarafindan belirlenecektir. Calis-
maniz, 1. Ek’te verilen “Degerlendirme Formu” veya “Kontrol Listesi’ndeki
Olcitlere gére degerlendirilecektir. Calismanizi yaparken bu dlgutleri dikkate

aliniz.
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3.2. BILGISAYARDA ETIKET OLUSTURMA

Tasarimcl, etiket tasarimi eskiz calismalarini bilgisayara aktardiktan sonra vektérel tabanli gizim
programinda calismasina baglar. Calisma Uzerinde fotograf kullanma veya zeminde dolgu ve
doku kullanma iglemleri igin piksel tabanli program kullaniimalidir.
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Gorsel 3.16: Etiket tasarimi eskizi Uzerinden ¢izim

3.2.1. Bilgisayarda Etiket Tasarimi Agsamalari

Tasarimci, amatorce hazirladigi eskiz ¢calismasini dijital hale getirerek uygun program yardimi ile
profesyonel kalitede bir etikete donustirir. Bdylece Urlinu ilgi odag héline getirir. Tasarim yapilir-
ken takip edilecek asamalar ve dikkate alinacak bazi hususlar vardir.

® Secilen UrlGine uygun bir renk belirlenerek etiketin zemini olusturulur. Zeminde kullanilan
renk ve gorsel dgeler, Grinun 6zelligini yansitmali ve Urlin hakkinda tlketiciye bilgi ver-
melidir.

® Tuketici, Grinin ambalajini agmadan Urin Gzerindeki etiket tasarimindan Grinin igerigi
hakkinda bilgi edinebilmelidir.

* Tasarlanan etiketin icerigine uygun gorsel 6geler, vektérel gizim programi yardimi ile
cizilir ve renklendirilir. Gérsel kullaniimadiginda renkler ve sekiller Grindn ne olduguyla ilgili
fikir vermelidir.

® Tasarimcl, calismalasinda kullandigi her gérsel 6geden sorumludur. Kullanilan yazi ka-
rakterlerinin boyutu, kalinhigi veya inceligi amaca hizmet etmelidir.
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Her gorsel 6ge, Uriin hakkinda tlketiciye bilgi vermelidir.

Baski aninda yasanabilecek sorunlar dikkate alinarak calismaya devam edilmelidir. Belirle-
nen Ol¢cliniin tasma pay! da hesaba katilarak yeni bir sayfa agiimaldir. Agilan sayfa Gizerine
artndn logosu, gorsel égeler ve metin alanlarinin yerlesimi yapilarak calismaya devam edil-
melidir. BOylelikle markayi ve Grininid mukemmel bir sekilde yansitan bir tasarim yapilabilir

(Gorsel 3.17).

Gorsel 3.17: Etiket tasarimi eskizi Gizerinden ¢izim

Firmaya ait logo, geri dénlsim isaretleri ve diger bilgilendirme isaretleri tasarima baslanma-
dan 6nce vektdrel tabanli ¢izim programinda hazirlanmalidir. Tasarim i¢in simge ve logolarin
vektorel tabanli ¢izim programinda ¢izilmesi istenmeyen gérintulerin olusmasini engeller.
Yazi karakterinin algilanabilir ve estetik gériinebilmesi tasarim butinltgu icin énemlidir. Kul-
lanilan yazi alanlarinin blyukligu ve yazinin puntosu rahatca okunabilecek sekilde olmalidir.
Okunabilecek en kiigik yazi boyutu 5-6 puntodur. Bu durum kullanilan yazi karakterinin 6zel-
ligine (font) gore farkhhk gosterir. Kullanilan yazi karakterinin serifli olmasi, enine genis veya
kalin bir yapida olmasi daha kugik puntolarin da okunabilmesine olanak saglar.

Tasarimci kullanacagi ambalaj simgelerini, simgelerin boyutuna ve yerine dikkat ederek yer-
lestirmelidir. Simgelerin blylk olusu Urinln éniine gegerek istenmeyen sonuglar dogurabilir.
istenenden kiigiik kullanildiklarinda ise yapilmasi gereken uyarilar ve bilgilendirmeler eksik

kalir. Simgeler ayirt edilebilecek blylklikte olmalidir.
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Etiket Gzerindeki bilgilerin tlketici saghgi agisindan dogru olmasi ve yasalara uygun bir sekil-
de dizenlenmesi gerekir. Etiket Gzerinde bulunmasi gereken bilgiler; Urtnlerin fiziksel, kim-
yasal 6zelliklerini ve besin degerlerini 6grenmek agisindan oldukg¢a dnemlidir (Gérsel 3.18).

SIZMA ZEYTIN YAGI

L & 2

Gorsel 3.18: Etiket Uzerine simge ve bilgilerin eklenmesi

Etiket tasarimi Gizerinde bulunmasi gereken bilgiler sunlardir:

Uriiniin logosu

Uriindin igindekiler kismi
Uriintin net miktarini belirten
kisim

Uretimi yapan firmanin adi
ve net adresi

Uretim yeri

Seri numarasi ya da parti nu-
marasi

Uretimin izin tarihi

Uriiniin ait oldugu tlke

Son kullanma tarihi

Uriine 6zel uyari varsa onun
bilgisi

Muhafaza ve kullanim bilgileri

1950'den beri

Zyﬁ?ﬁ ';ng,f

SIZMA ZEYTIN YAGI

* ok ok ok ok
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Gorsel 3.19: Etiket tasariminin son hali

Tasarimcl, ¢alismasini vektorel ¢cizim programinda tamamladiktan sonra CMYK renk formatina
cevirmelidir. Kullanilan programin kendi kayit formatinda kaydetmelidir. Calisma Uzerinde bulu-

nan

batun ekleri bir dosyanin igine kaydetmelidir.
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Etiket Tasarim Ornekleri
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Gorsel 3.20: Etiket tasarimlari
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Gorsel 3.21: Etiket tasarimlari
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Gorsel 3.22: Etiket tasarimlari
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Gorsel 3.23: Etiket tasarimlari
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OGRENME BIiRiMi: ETIKET TASARIMI
UYGULAMA ADI : Bilgisayarda Etiket Tasarimi Yapma

: Bilgisayarda etiket tasarimi yapmak.

Arac Gerec
1. Bilgisayar
2. Tarayici
3. Grafik tasarim programlari

Asagidaki islem basamaklarini dikkate alarak vektdrel tabanli gizim
programinda etiket tasarimi ¢iziniz.

islem Basamaklar
1.

Atdlye 6nlaginuza giyiniz; arag gerecinizi, calisma alaninizi is saghgi
ve guvenligi tedbirlerini alarak 6zenle hazirlayiniz.

Belirlediginiz bir sektére ait etiket drneklerini inceleyiniz.

Uzerine eskiz yaptiginiz kagidinizi tarayici yardimiyla veya tarayici
Ozelligi bulunan bir cihazla tarayip bilgisayar ortamina tasiyiniz.
Vektorel tabanli ¢izim programinda konunun icerigine uygun isim ve-
rerek yapilacak etiket dlctistinde bir sayfa aginiz.

Eskizi vektdrel tabanli ¢izim programinin sayfasina tagiyiniz.

Cizerek ve renklendirerek calismaniza son seklini veriniz.
Calismaniz slresince sabirli ve dikkatli olmaya 6zen gésteriniz.
Bitirdiginiz calismanizi orijinal formatinda ve baskiya uygun formatta
kaydediniz.

Calismanizin ¢iktisini alarak 6gretmeninize teslim ediniz.

Degerlendirme

Uygulama calismanizin slresi 6gretmeniniz tarafindan belirlenecektir. Calis-
maniz, 1. Ek’'te verilen “Degerlendirme Formu” veya “Kontrol Listesi’ndeki
Olcutlere goére degerlendirilecektir. Calismanizi yaparken bu Olgitleri dikkate
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OLCME VE DEGERLENDIRME

A) Asagida verilen ciimlelerin basindaki parantezlere ciimleler dogru ise “D”, yanlis ise
“Y” yaziniz.

1. () Etiketlerin, marka degerini artirma etkisi vardir.

2. () Uriin hakkinda verilecek 6énemli bilgiler, etiketin en iistiine kiigiik puntolarla yazilma-
hdir.

3. ( ) Etiket cesitleri k&git bazl etiketler ve plastik bazli etiketler olmak uzere ikiye ayrilir.

B) Asagida verilen cimlelerde yer alan bosluklari uygun ifadelerle doldurunuz.

4. Kagit bazli etiketlerin retiminde ......................... malzemeler kullanilir.
5. Isi, 181k ve neme kargi dayanikliolan ...................... farkh alanlarda kullanilabilir.

C) Asagida verilen sorularin dogru cevaplarini isaretleyiniz.

6. Asagidakilerden hangisi kullanim alanlarina gére giinimuzde en ¢ok tercih edilen etiket
trlerinden biri degildir?
A) Fiyat etiketleri
B) Marka etiketleri
C) Punto etiketler
D) Uyari etiketleri
E) Urin etiketleri

7. Asagidakilerden hangisi kagit bazl etiket tlrlerinden degildir?
A) Fastyre
B) Floresan
C) Kirilgan
D) Kuse
E) Termal

D) Asagida verilen sorularin cevaplarini noktali yerlere yaziniz.

8. Plastik bazli etiketlerin 6zelliklerini agiklayiniz.

9. Etiket tasarimi yapan bir tasarimcinin dikkat etmesi gereken hususlardan U¢ tanesini

yaziniz.
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KONULAR
4.1. AMBALAJ MAKETI ON HAZIRLIKLARI
4.2. AMBALAJ MAKETI ESKizi

NELER OGRENECEKSINiz?

* Ambalajin tanimi, 6zellikleri, cesitleri ve ambalaj
tasariminda dikkat edilmesi gereken hususlar

* Kutu ambalajinin yapisal ogeleri; kesim, kirim ciz-
gilerinin kullanilacagi yerler ve konuya yénelik a-
rastirmalari dosyalama

« Ornek ambalaj calismalarini inceleme; iiriin icin uy-
gun ambalaj tasarimi, ambalajin acilimi ve kesim, ki-
rim yerleri; Griin icin pencere veya separator 6lculeri

« Uc boyutlu ambalaj maketi hazirlama

TEMEL KAVRAMLAR
ambalaj * separator - pencere
kesim * kirim

HAZIRLIK CALISMALARI

1. Markette ilginizi en c¢ok ceken ambalajlar
hangileridir? Urlinin paketini tarif ediniz.

2. llk defa aldiginiz ve bircok markanin urettigi bir
urinu secerken nelere dikkat edersiniz?

3. Sizceokul kantinindenaldiginiziriinlerinambalajlari

nasil olmalh?
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4.1. AMBALAJ MAKETI ON HAZIRLIKLARI

Ambalajl hazirlamadan énce ambalajin kullanilacagi
artin, hedef kitle, kullanilacak malzeme, nakliye vb. bir-
¢cok &6n bilgiye sahip olmak gerekir. Tasarimci, bu bilgi-
ler 1s13Iinda hazirlayacagi ambalajin maketini hazirlar;
kullanilacak malzemeye uygun tasarim yapar.

4.1.1. Ambalaj

TDK Gilincel Tirkge Sozlik’te “Esyayi sarmaya yara-
yan mukavva, kagit, tahta, plastik vb. malzeme.” ola-
rak tanimlanmistir. Ambalaj icinde tasidigi Grinu dis
etkenlerden korur ve Uriine ait bittn bilgileri en etkili
ve net bicimde disariya iletir. Ambalaj, buglnki hali-
ne gelene kadar cesitli asamalardan gecmistir. Eski
dénemlerde cuval, deri, toprak kap, ahsap sandik gibi
malzemeler ambalaj olarak kullanilirken glinimizde
cogunlukla kagit, karton, ahsap, plastik, cam, metal
vb. malzemeler kullaniimaktadir. Bu ydénlyle daha
ekonomik ve fabrika Uretimleri ile daha ulasilabilir hale
gelmisgtir.

Onceleri yalnizca tasima ve saklama islevi olan am-
balaj, ginuimuzde icindeki Urdnun reklamini yapma,
diger Urin ambalajlariyla rekabet edebilme 6zelligine
sahiptir. Bunun yani sira icinde bulunan malzemenin
saglikl bir sekilde tiketiciye ulasmasi, Griinin hangi
kosullarda, nasil saklanmasi gerektigi ile ilgili bilgilen-
dirme ve iletisim bilgilerini verme gibi islevleri de vardir.
Ambalaj Uranun giysisidir. Alici Gzerinde iyi bir izlenim
birakmasi icin saglam ve sik bir tasarim gerektirir.

Sanayi Devrimi sonrasi kitlesel tiketimin hizla artmasi;
aranleri korunma, depolanma ve taginma problemleri-
ni beraberinde getirmistir. Bunun sonucunda ambalajin
ihtiyaci artmis ve ambalaj tasarimi da bu slrecte 6nem
kazanmigtir. Uzerinde bulunan tipografik unsurlar,
renkler, illistrasyon ve fotograflar ile aslinda bir iletisim
araci olan ambalajin tiketiciyle gérsel iletisimi dogru
kurabilmesi ve bunu yaparken de etkileyici olabilmesi
gerekir.

100
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Ambalaj Atig1 Cop Degildir!

Glnimuizde; hemen hemen
her sektdérde birgcok Grindn
ambalajli olarak satisa sunul-
dugunu goériyoruz. Ambalaj
malzemelerinin Uretimi ve tu-
ketimi de endustriyel gelismeye
paralel olarak her gecen gln
artiyor. Giindelik hayatimizda
pek cok Urini cam, metal,
plastik, kagit gibi ambalajlar
icinde satin aliyoruz. Ambalaj
kullanimi artarken ambalaj atigi
miktari da artmaktadir. icinde-
ki arinu tlkettikten sonra bu
ambalaj atiklar ise yaramaz
deyip ¢dpe atiyoruz. Ne yazik
ki cop alanlarinda ¢oép daglari
olugturuyoruz. Urettigimiz atigin
yaklasik %20’sini ambalaj atig
olusturmaktadir.

Dogal kaynaklarimiz dunya
nufusunun artmasi ve tiketim
aliskanliklarinin degismesiyle
birlikte her gecen glin azaliyor.
Oncelikle az atik olusturmaliyiz,
atik olusumunun  kaginilmaz
olmasi durumunda da atiklari-
mizi tekrar kullanmal veya geri
dénusime gitmesine yardimci
olmaliyiz.

Kaynak:

https://webdosya.csb.gov.tr/db/
bolu/icerikler/atiklarin-geri-kazani-
mi-20180222082519,pdf (18.08.2021)

)
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Ambalaj tek basina bir iletisim araci olmakla beraber formu, Uretim malzemesi ve grafik tasari-
miyla bir batiin olarak dustnilmelidir. Formunun kullanigli olmasinin ve Grini muhafaza etmesi-
nin insan hayatini kolaylastirdigi sdylenebilir. Ancak Utzerinde grafik tasarim olmadan ambalajin
icinde ne oldugunun anlasilabilmesi oldukca guctur. Grafik tasarim; Grlnin icecek mi, temizlik
malzemesi mi, deterjan mi yoksa hazir gorba mi oldugunun anlagiimasini saglar. Ayni zamanda
tuketiciye Grundn son kullanma tarihi, icerigi gibi gerekli bilgileri sunar. Bu durumda, tasarimci,
ambalaj Gzerindeki tasarim sayesinde hedef kitleyle dogru sekilde gdrsel iletisim kurabilmelidir.

. Etkinlik
7

Okul kantinindeki ambalajli iirlinleri inceleyiniz. Asagidaki sorularin ce-
vaplarini noktali yerlere yaziniz.

1. En c¢ok tercih ettiginiz Granidn ambalajinin 6zelliklerini yaziniz.

2. Kantinde en c¢ok talep edilen Grinin ambalajinin 6zelliklerini yaziniz.

3. Siz bir ambalaj tasarliyor olsaydiniz bu ambalajin ne tir ézellikleri olsun is-
terdiniz? Yaziniz.
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4.1.2. Ambalaj Ozellikleri
Ambalajlarin Urin 6zelliklerine uygun olmasi disinda farkh ézellikleri de bulunur. Ambalajin tasa-
rimi ve Uretimi agamasinda asagidaki 6zellikler gdz é6nunde bulundurulmalidir.

Urlin igin farkl Greticilere farkli tasarimlar sunmalidir.
Nakliye Ucreti ve Urun fiyatini ¢ok fazla etkileyecek maliyette olmamalidir.

Sagliga zararli maddelerden Uretiimemelidir.

Geri donUstardlebilir olmahdir.

Urliniin yapisini bozmadan taginmasini saglamalidir.
Hedef kitleye mesaji dogru vermeli ve Uriin 6zelliklerini aktarmahdir.
Depolama, nakliye ve satis sirasinda kirlilige sebep olmamalidir.,

Ambalajdan Beklenen islevler

Ambalajin koruma, tasima, depolama, pazarla-
ma, gevre Kirliligi ve tlketici acisindan gesitli is-
levleri vardir.

Ambalajin, icindeki Grinu koruma ile il-
gili iglevleri:

Mikrobiyolojik yénden korumasi,

Nem ve atmosferik etkiler yéninden
korumasi,

Carpma, ezilme gibi mekanik etkiler-
den korumasidir (Gorsel 4.1).

Gorsel 4.2: Tasima

Ambalajin depolama ile ilgili iglevleri:
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Ust tste yigilabilmesi,

Depo icinde yerinin kolayca degistiri-
lebilmesi,

Ayirt edilebilmesinin kolay olmasidir
(Gorsel 4.3).

Gorsel 4.1: Metal ambalaj

Ambalajin tasima ile ilgili iglevleri:

Uriinleri bir arada tutmasi,

Nakliye aracina kolaylkla yuklenip bo-
saltabilmesi,

Akma, dékulme, patlama, ve dagiima-
yI 6nlemesidir (Gorsel 4.2).

bl
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Gorsel 4.3: Depolama
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Ambalajin pazarlama ile ilgili islevleri:
® Satis sirasinda géze carpmasi,
* Rafta az yer isgal etmesi,
* icindeki Uriinle ilgili bilgi verici yazilar
bulundurmasi,
® Yasal kurallarla kisitlamalara uygun ol-
masidir (Gorsel 4.4).

Ambalajin tiiketici acisindan iglevleri:

® Cekici bir gérinimde olmasi,

® Kullanigh ve acilir kapanir dzellikte ol-
masi,

e Urlin tilketildikten sonra ambalajin ye-
niden kullanilabilmesi,

® Tasidi@r Urtn ile ilgili gerekli bilgileri
bulundurmasidir (Gérsel 4.5).

Ambalajin cevre kirliligi acisindan islevleri:
® Kullanildiktan sonra atildiginda kimya-
sal ve biyolojik yonlerden cevre Kkirlili-

gine neden olmamasi,

* Bulylk ¢6p yiginlari meydana getirip
yok edilmesi icin ilave bir masraf ge-
rektirmemesi,

® Geri dontusimle tekrar kullanilir héle
getirilebilmesidir (Gérsel 4.6). Gorsel 4.5: Tlketici

anttim Grafigi

Gorsel 4.6: Geri donlsim
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4.1.3. Ambalaj Cesitleri

Ambalajlar kullanim durumuna gére ve kullanilan malzemeye gore farklilik gésterir. Kullanim du-
rumuna gbre olan ambalajlar satis ambalaji, grup ambalaji, nakliye ambalajidir. Bunlar tretim,
nakliye ve hedef kitleye dogrudan ulastirilirken Griiniin zarar gérmesini engellemek i¢in kullanilan

ambalajlardir.

Gorsel 4.7: Cesitli ambalajlar

Kullanilan Malzemeye Gére Ambalajlar
Ambalajlar icindeki malzemenin 6zelligine gére ahsap, cam, metal, aliminyum, plastik, ka
git gibi farkl malzemelerden Uretililir.

Ahsap Ambalaj

Dayanikl yapisi ile Grintn korunakl bir sekilde ulagimini saglar. Ahsap, organik bir malzeme
oldugu igin ambalaj sektdriinde kullanilir. Havalandirma ézelliginden dolayi taze meyve, sebze
satisinda tercih edilir. ihracatta kullanilan ahsap ambalaj malzemeleri; palet, kasa, kutu, sandik
ve varillerdir (Gérsel 4.8).

Goérsel 4.8: Ahsap ambalajlar

104



Metal Ambalaj

Cesitli minerallerin islenerek saflastiriimasi sonucunda Uretilen metal ambalajlar, tasidiklar Gru-
nii nem ve isiktan korur. ilag, kimya, kozmetik ve gida sanayisinde genellikle konserve kutulari,
mesrubat kutulari, boya kaplari vb. olarak kullanilan ambalaj ¢esididir (Gérsel 4.9). Kétu sartlarda
bile Griinin bozulmadan saklanmasini saglar.

AMBALAS MAKET HAZIRLAM*

Goérsel 4.9: Metal ambalajlar

Aliiminyum Ambalaj

Buhar ve gaz gecirgenliginin olmasi, igindeki gi-
dada nem ve su kaybinin olusmamasi, gidanin
bozulmasini 6nlemesi, kolay boyanabilir olmasi,
metal kaplara oranla daha hafif ve sekillenebilir
olmasi aliminyum ambalajlarin avantajlarindan-
dir. Dis etmenlere karsi tenekeye gore dayanik-
siz ve saglik agisindan zararl olusu dezavan-
tajlarindandir. Aliminyum folyoyla sekil verilmis
paket kaplar veya torbalarda, poset tarzinda pa-
ketlerde kullanilirlar (Gérsel 4.10).

Gorsel 4.10: Aliminyum ambalaj

Plastik Ambalaj

Plastikler; 1s1 ya da basing etkisiyle yumusatilip kaliba dékme ve haddeleme gibi ¢esitli ydntem-
lerle bicimlendirilebilen, bu bicimlerini soguyunca da koruyabilen, yapay ya da dogal, cogunlukla
organik malzemelerdir. Plastik ambalajlar; hafif, saydam, nem gecirgenligi diisik, haserelere kar-
si dayanikli olmasi, kimyasal veya atmosferik durumlardan etkilienmemesinden dolayi kullanim
alani genis olan ambalajlardir. Poset, torba, canta, kavanoz, sise, kova, tip, bidon gibi sonsuz

sekillerde bicimlendirilerek kullanilir (Gorsel 4.11).

Gorsel 4.11: Plastik ambalajlar
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Kagit Ambalaj

Uretim maliyetinin az olmasi, az yer kaplamasi, depolama ve tagima maliyetinin az olmasi ve
geri donisim yapilabiliyor olmasindan dolayi en ¢ok tercih edilen ambalaj tartdir. Kagidin ham
maddesi selllozdur. TDK Giincel Turkge Sézlik’e gbre sellloz; bitkilerde hiicre yapisinin blyuk
bir béluminl olusturan kagit, yapay ipek ve patlayici maddelerin yapiminda kullanilan karbon-
hidrattir.
Kagit ambalajlar bes farkh sekilde kullanilir.
* Sargilik kagitlar: Uriinlerin etrafini sarmak igin kullanilan kagit tirleridir. Margarinlerin
ambalajlari sargili k&git drnegidir.
¢ Karton kutular: Kuru gida ve toz deterjan kutulari érnek verilebilir.
® Oluklu mukavva kutular: Bir veya daha fazla oluklu mukavva tabakanin alt ve Ust yu-
zeylerinin diiz tabaka mukavvayla kaplanmasi ile meydana gelen driindar. Uriinlerin nak-
liye agamasinda kullantlir.
® Viyol: Yumurtalarin tasinirken birbirine ¢arpmasini énleyen, gukurlari olan bir ambalaj
taradar.

Gorsel 4.12: K&git ambalajlar

Cam Ambalaj

Cam, silis kumunun cesitli katki maddeleri ile yiuksek sicakliklarda eritilerek sekillendiriimesiyle
meydana gelir. Ozellikle sivi ve yari sivi Griinlerin ambalajinda kullanilir. Gida, kozmetik, kimya
sanayisinde kullaniimaktadir. Gaz, su buhari, koku ve sivi gegirgenligi yoktur. Cam ambalajlar
saglik agisindan glven verir ve icindeki Grinin géranurligind saglar. Agirhgi nedeniyle nakliye
masraflarinin fazla olusu ve kirilma gibi dezavantajlari vardir. Geri dénisim agisindan avantaj-
hdir.

TR

Ué

Gorsel 4.13: Cam ambalajlar
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4.1.4. Ambalaj Cesitlerinde Geri Déniisiim

Geri donusim, atiklarin &zelliklerinden yararlanilarak icindeki bilesenlerin fiziksel, kimyasal
veya biyokimyasal yontemlerle baska Urlinlere veya enerjiye g¢evrilmesidir. Ambalaj c¢esitlerinin
geri dénlsumdinu iceren bilgiler Cevre ve Sehircilik Bakanligi, Bolu, Atiklarin Geri Kazanimi,
20180222082519 numarall dokimandan alinmistir.

Metal ambalaj: Evlerimizde gida ve icecek ambalajinda kullanilan iki ¢esit metal ambalaj mal-
zemesi vardir. Bunlar teneke ve aliiminyumdur. Metal ambalajlarin eritilerek geri dontsturdlmesi
kullaniimis daha az enerji ve hammadde tiketimi demektir. Kullaniimig aliminyumdan aliiminyum
Uretilerek sera gazi emisyonu % 95 ve atik su kirlenmesi % 97 oraninda azaltilabilir.

Plastik ambalaj: Plastik ambalaj atiklari yikanip eritilerek, grandil haline dénusturiimektedir. Gra-
nadller ikincil Grin imalatinda hammadde olarak; plastik torba, marley, pis su borusu, elyaf, dolgu
malzemesi, gergeve ve sera Ortlst imalati ile otomotiv sektériinde kullanilarak yeni trinler elde
edilmektedir. 2.5 It.’lik bir plastik sise geri kazanilip Gretimde kullanilirsa 6 saatlik 60 watt’lik elekt-
rik enerjisini tasarruf etmek mumkundur. 25 adet geri kazaniimis icecek sisesinden bir plastik
mont elde etmek mumkindur.

Kagit ambalaj: Kullaniimis kartonlardan; masa, sandalye ve dolap gibi mobilyalar tretilmekte,
ayrica kagit hammaddesi olarak da kullaniimaktadir. Bir ton atik k&gidin geri dénusturilmesi ile
17 agag kurtariimis olur.

Cam ambalaj: Cam siseler depozitolu ve depozitosuz olarak ikiye ayrilir. Depozitolu siseler te-
mizlenerek tekrar kullanilir. Depozitosuz olanlar ise, diger cam atiklar ile birlikte renklerine goére
ayrilmak suretiyle, kirllarak cam tozu haline getirilerek yeni Griinlere dénlstiralur. Bir cam sise
geri donUsturuldigunde, 100 Wattlik bir ampull dért saat yakabilecek enerji tasarruf edilmis olur.

2. Etkinlik 7

Asagida verilen ambalaj ¢esitlerinin kullanildig: Griinleri yaziniz.

Kagit ambalaj Plastik ambalaj Cam ambalaj

AMBALAS MAKET HAZIRLAM@

Uocoooooooooooocaoan Uooooooocooooooooooo Uoooooooooooooooooon
7 cooooooooooooooooa Zrooocoocooooooooooa Zrooocoocoooooocoooo
“hooooooooooonooaoas € ooooooo0o0ono0oo0no €hoooooooooanooonaoano

107

anttim Grafigi




zW\A&ALAA MAKET FAZIRLAMA

4.1.5. Ambalaj Tasariminda Dikkat Edilmesi Gereken Hususlar
Ambalaj tasarimi yapim asamasinda trtnin tim &6zellikleri g6z éninde bulundurularak tlketici
Uzerinde olumlu etki birakacak sekilde tasarim yapilmalidir.
® Tasarim sade ve estetik olmalidir.
*  Uriin hakkinda bilgi vermelidir.
* lgi gekici olmali, rakipleri arasindan siyrilabilmelidir.
* Kullanilan renkler Grinin 6zelligine ve tuketici Gzerinde birakacagi psikolojik etkiye goére
tercih edilmelidir.
* Ambalaj zerinde bulunmasi gereken marka, icindekiler, tiketim tarihi gibi zorunlu dgeler
kolay okunabilir olmalidir.
® Ambalaj tasarimi yapilirken kesim, kirim yerleri dogru hesaplanmalidir.

Tliketicl
davraniglart

N =
Ekonom
faktorler

=

Gorsel 4.14: Ambalaj tasarim slreci

4.1.6. Kutu Ambalajin Yapisal Ozellikleri

Kutu ambalaji tasarlanirken yapisal 6zellikler bilinmelidir. Kirim ve kesim yerleri, yapistirma payi,
kilit sistemleri, barkot, pencere ve tasarim alanlari UrGinin yapisina uygun olmalidir. Ambalajin
yapisal 6zelliklerinin yerlesimi, Griin 6zelliklerini tiketiciye iletebilecek sekilde planlanmalidir.
Kirim (Pilyaj) Yerleri: Katlama isleminin dizgiin ve kolay yapilabilmesi icin ezme isleminin yapil-
dig1 yerlerdir. Ambalajin tasarimi esnasinda noktali kesik cizgi ile belirtilir.

Kesim Yerleri: Kesilmesi gereken yerleri belirten cgizgilerdir. Ambalajin tasarimi esnasinda duz
cizgi ile belirtilir.

anttim Grafigl
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Perforaj: Kolay koparilmasi istenen bélimlere yapilan aralikli kesme islemidir.

Yapistirma Payi: Kesme ve kirim islemi bittikten sonra ambalajin kutu héline getiriimesi igin ya-
pistirilacak alandir.

Kilit Sistemleri: Ur(in ambalaja yerlestirildikten sonra kapagin rahat acilip kapanmasi igin gerekli
olan bélimddr. Ambalajin sekline gére farkli bicimlerde olusturulabilir.

Barkod Alani: Barkod, Urtine sayisal olarak verilen isimdir. Her Grinin kendine 6zgul bir kod nu-
marasi vardir ve bu kod baska bir Griinde kullanilamaz. Barkodlar, Griinin barkod okuyucuda oku-
tulup tanimlanmasi icin kullanilir. Genellikle ambalajin sol yan veya sag yan yuzune yerlestirilir.

Gorsel Tasarim Alanlari: Genellikle Urlin hakkinda bilgi veren, somut veya soyut gérseller kulla-
nilarak farkl tasarimlar yapilan alandir. Uriiniin tanitiminin yapildigi bélimdiir. Agirlikh olarak én
ve arka yuzde bulunur.

Separator (Ayirici): Ambalaj ile Grin arasina yerlestirilen karton, oluklu mukavva, strafor ya da
hava yastijina separatér denir. Carpmalara, dismelere karsi Grlnin zarar gérmesini édnlemek
icin kullanilir (Gérsel 4.15).

Gorsel 4.15: Separator

Pencereli Kutu: Uriiniin gériinebilmesi icin kullanilan, ayrica farkl tasarim imkanlari sunan bé-
[imdur. Kutu ambalajlar, tiketicinin paketi agmadan Urlini gérmesini saglar. Pencere igin be-
lirlenen alan genellikle 6n ytzde bulunur. Kutu igindeki trinln kutudan ¢ikmasini édnlemek igin
genellikle saydam bir malzeme ile kapatilir (Gorsel 4.16).

AMBALAS MAKET HAZIRLAM/*

Pencere

Gorsel 4.16: Kutu ambalajda pencere kullanimi
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/ Ust kapak kilidi \

Ust kapak
Yan kulak Yan kulak Gorsel tasarim alani
Yan yiiz On yiiz Yan yiiz Arka yiiz
Gorsel tasarim Gorsel tasarim alani Gorsel tasarim Gorsel tasarim alani
alani alani
=
°
&
=
g
3
Y
el
O
=
Pencere

Barkod alani

Yan kulak Alt kapak Yan kulak

Gorsel tasarim alani
Kesim ¢izgisi

......................... Kinm cizgisi (pilyaj)
Al kapak kilidi J
Gorsel 4.17: Kutu ambalaj agilimi
%. Etkinlik
Gorsel 4.18’ deki kutu ambalaj ile ilgili agsagidaki
sorularin cevaplarini noktali yerlere yaziniz.
1. Ambalaj ne tdr bir Grln icin tasarlanmis olabilir? ] »
b/ ] N
A

Gorsel 4.18: Kutu ambalaj

anttim Grafigl
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§. Etkinlik
p

Gorsel 4.19°da numaralan- (5 H
dirilan bélimlerin isim- | ] F

lerini asagiya yaziniz. 1 } | i 2 |
T
2. 4] L |
B | = @ |
. ; . ;

Gorsel 4.19: Kutu ambalaj acilimi

4.1.7. Ambalaj Arastirma, Veri Toplama ve Dosyalama

GUnUimuzde insanlar eskiye oranla daha hareketli bir yasam strmektedir. Ambalaj tasarimi da
bu hareketli yasama ayak uydurmak durumundadir. Robert Opie’nin (Rabirt Opi) 1991 yilinda
yayimlanan “Packaging Source Book” [Pekicin Sours Buk (Paketleme Kaynak Kitabi)] adli kita-
binda ambalajin temel islevleri, “Griine daha iyi bir gérinim kazandirmak ve GrGnin dagilimini
kolaylastirmak” olarak verilmistir. GUnimuz sartlarinda bu isin daha karmasik bir yapi kazanma-
siyla birlikte ambalajin iglevleri artmigtir. Bu yeni iglevler arasinda gdze en ¢arpani, gittikge artan
pazar karmasasi igindeki konumudur (Gorsel 4.20). Ambalaj tasariminin ana hedefi, bir tlketim
aranundn kimligini ya da islevini ayirt edici bir ydntem aracihgiyla ileterek trine iliskin pazarlama
problemlerine ¢6zim bulmakir.

Sektdr analizinde detayli arastirmalar yapilarak elde edilen veriler dosyalanmalidir. Bir Griinden
her acidan maksimum fayda saglamak adina ambalaj, bu veri dosyasindaki bilgiler dogrultusun-
da tasarlanmalidir. Sektér analizinde arastiriimasi gerekenler sunlardir:
e Urin ile ilgili meveut biitin 6zellikler ve benzerlerinden ayrilan dzellikler
* Hedef kitle ile ilgili demografik (cinsiyet, yas, gelir dizeyi, meslek, egitim vb.) 6zellikler
basta olmak Gzere Urinden beklenenler
* Pazar ile ilgili pazar olarak kabul edilecek bdlge basta olmak tzere Urln ile ayni ve ben-
zer olan Urinlerin pazar paylar ve satis cirolari
*  Uretici firmanin kisa ve uzun vadede iriinden net beklentileri
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Gorsel 4.20: Ambalajin market raflarindaki gérinima

111




37>vME’>ALAA MAKET HHAZIRLAMA

OGRENME BIiRiMi: AMBALAJ MAKETi HAZIRLAMA
UYGULAMA ADI : Kutu Maketi igin On Hazirlik Yapma

AMAC : Kutu maketi icin gerekli 6n hazirliklari yapmak.
Arac Gerec

1. Ambalaj 6rnekleri

2. Bilgisayar

Belirlediginiz bir Uriin icin farkh 6zelliklerde ambalaj 6rnekleri arastirip,
asagidaki islem basamaklarini dikkate alarak dosya olusturunuz.

islem Basamaklari

1. Atélye 6nligunizi giyiniz; arag gerecinizi, calisma alaninizi is saghgi
ve glvenligi tedbirlerini alarak 6zenle hazirlayiniz.

2. Belirlediginiz Griinin tam &zelliklerini yaziniz.
Zamaninizi verimli kullanmaya, sabirli ve dzenli calismaya dikkat
ediniz.

4. Belirlediginiz Urln ile ayni ve benzer olan Urinlerin pazar paylari hak-
kinda bilgi toplayiniz.

5. Uretici firmanin kisa ve uzun vadede Uriinden beklentilerini belirle-
yiniz.

6. Bilgisayar ortaminda dosya olusturarak topladiginiz verileri olusturdu-
gunuz dosyaya kaydediniz.

7. Hazirladiginiz dosya sunumunu sinif ortaminda arkadaslarinizla

saygl ve sevgi cercevesinde paylasiniz.

Degerlendirme

Uygulama calismanizin suresi 6gretmeniniz tarafindan belirlenecektir. Calis-
maniz, 1. Ek’te verilen “Ambalaj Maketi Hazirlama Degerlendirme Formu” veya
“Ambalaj Maketi Hazirlama Kontrol Listesi’ndeki dlcutlere gore degerlendirile-
cektir. Calismanizi yaparken bu 6lgitleri dikkate aliniz.

anttim Grafigl
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4.2. AMBALAJ MAKETI ESKizi

Ambalaj maketi eskizi olusturulurken kutunun acik ve kapali hali birlikte disuntlmelidir.
Ambalaj icin tasarimi yapilacak Uriinii tagiyabilecek 6zellikte bir malzeme secilmelidir. istenen
ambalaj 6zelliklerine dikkat edilerek yani “Pencereli bir ambalaj mi yoksa penceresiz bir ambalaj
mi olmali, gorsel tasarim alani icin belirlenen bdlimin genisligi ve kutunun ebatlari nasil omall,
separatodre ihtiyag var mi?” gibi sorular yanitlanmali ve bu dogrultuda tasarim sireci dogru
planlanmalidir.

4.2.1. Kutu Acilimi Cizimi

Kutu acilimi cizilirken dikkat edilecek bazi noktalar vardir.

*  Olciler bire bir cizilmelidir. Olciilerde meydana gelen hata, kutu katlanip Gi¢ boyutlu ma-
ket héline getirilene kadar anlasilamaz. Geri dénlsu zor hatalarin meydana gelmemesi
icin 6lcim dizgin yapilmalidir.

* Malzeme israfi yapmamak icin acihm cizilecek malzeme, 6l¢llerine uygun ve dizgln
kesilmeli ya da acilimin digtan disa en ve boy 6lcllerine gbre dértgen bir gerceve icine
oturtulmahdir.

® Cizim yapilirken her adimda bir énceki adimin élgtistinden yararlaniimali ve bu siirekli
kontrol edilmelidir.

* Geometrideki “iki noktadan bir dogru geger.” kuralina uyularak cizilecek her dogru igin
en az iki noktadan 6lciim yapiimalidir. Yatay ve dikey cizgilerin egri gizilmemesi icin bu
kurala uyulmasi zorunludur.

* Ambalaj i¢in kullanilacak malzeme, verilen élcilere uygun sekilde bire bir kesilmeli ya
da verilen dlgulere uygun bir dikddrtgen, malzeme Uzerine ¢izilmelidir. Malzeme, ¢izim
yapilacak yere sabitlenmelidir.

* Yatay cizgilerden baglanarak gizim islemine gecilmelidir. ilk olarak yan yapistirma kulagi,
karton kenarina sifir ya da cizilen dikdértgene sifir ¢izilmeli; disey cizgilerle gizime de-
vam edilmelidir.

e Kutu tabaninin katlama ve kilit kulaklari gizilmeli, kesim ve kirim cizgileri digindaki fazla
cizgiler silinmelidir. Kesim cizgileri, diz ¢izgi ile belirlenmeli; kirim ¢izgileri, kisa ¢izgi ile
belirlenmelidir. Boylece cizim tamamlanmis olur.
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Gorsel 4.21: Kutu acilimi ¢izim asamalari
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OGRENME BiRiMi: AMBALAJ MAKETi HAZIRLAMA

UYGULAMA ADI : Kutu Ambalaj Eskizi Yapma
AMAC : Kutu maketi igin eskiz yapmak.
Arac Gereg

1. 50x70 cm resim kagidi

2. CGizim kalemi

3. Silgi

4. Cetvel

Gorsel 4.22°de verilen dlciileri ve asagidaki islem basamaklarini dikka-
te alarak kutu ambalajin acik halini giziniz.

35cm

55cm

-

[ 7cm

35cm
| 1,5cm

7.2cm

24cm 24cm

25cm

23cm 26 cm

2cm

Gorsel 4.22: Kutu ambalaj acihminin ¢izimi

islem Basamaklari

1.

6.
7.

Atblye 6nluaginizu giyiniz; arag gerecinizi, galisma alaninizi is sagli-
g1 ve guvenligi tedbirlerini alarak 6zenle hazirlayiniz.

Maketin olusturulacagi ylzeyi sabitleyerek malzemenin kaymamasi-
na dikkat ediniz.

Maketin acilimini élgllerine dikkat ederek ylizeye ciziniz.

Maketin kesim ve kirim yerlerini ylzeye ¢iziniz.

Ambalaj agiliminin gizimini bitirdikten sonra ciziminizi inceleyiniz. Ol-
¢ulerin, kirm ve kesim cizgilerinin dogrulugunu kontrol ediniz.

Planli ve disiplinli calismaya 6zen goésteriniz.

Calismaniz bittikten sonra ¢alisma ortaminizi temizleyiniz.

Degerlendirme
Uygulama galismanizin suresi 6gretmeniniz tarafindan belirlenecektir. Ca-
ismaniz, 1. Ek’te verilen “Ambalaj Maketi Hazirlama Degerlendirme Formu”

veya “Ambalaj Maketi Hazirlama Kontrol Listesi’ndeki 6lgutlere gére deger-
lendirilecektir. Calismanizi yaparken bu dl¢utleri dikkate aliniz.
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4.2.2. Ambalaj Caligsma Ornekleri
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Ambalaj Eskiz Calismalari

Gorsel 4.29: Kutu ambalaj gizimi érnekleri
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4.2.3. Ambalaj Maketi Hazirlama
Eskiz calismasinda beyin ve el koordinasyonu saglanir. Bu sayede 6zglrce, hicbir kisitlama olma-

olmadan ¢ok sayida fikir Uretilebilir. Ambalaj maketi hazirlarken dikkat edilmesi gereken asa-

malar sunlardir:
Hazirlanmasi planlanan ambalaj eskizinin élctleri belirlenerek ambalaj icin secilen uy-
gun malzemeye cizilir. Olglilere dikkat edilmesi gerekir ¢linkii 1 mm hata bile amba

lajin hazirlanmasinda sorun olusturur (Gorsel 4.30).
Kesim i¢in duz ¢izgi, kinm i¢in kesik ¢izgi kullanilir. Kirim, kesim cizgilerinin dogru belir-

[ ]
lenmesi cok dnemlidir. Ambalajin tasarimi bittikten sonra kutu héline dénusebilmesi icin

kirnm ve kesim c¢izgilerinden faydalanilir.

m!plnrm

pmpu:L

17

11y
16

15

Ty

W

Ambalaj maketi hazirlarken maket belirlenen kesim ¢izgilerinden kesilir (Gorsel 4.31).

Gorsel 4.30: Cizim asamasi

i
]
|
i
I
i

g

Gorsel 4.31: Kesim agsamasi

Kirilma yerleri, ambalaj icin se¢ilen malzeme burusturulmadan dikkatli bir sekilde kirim

cizgilerinden katlanir (Gorsel 4.32).
Yapistiriimasi gereken parca, yapistirici yardimi ile yapistirilir.

=

Gérsel 4.32: Kinm ve yapistirma asamasi
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® Ambalaj maketinin kapak kilit sistemleri de kullanilarak, makete son sekli verilip maket kutu héline
getirilir (Gorsel 4.33).

g

Gorsel 4.33: Ambalaj maketi

OGRENME BIRIMi: AMBALAJ MAKETi HAZIRLAMA
UYGULAMA ADI : Kutu Ambalaj Eskizi Yapma
AMAC : Ambalaj tasarimi igin eskiz ¢alismalari yapmak.

Arac Gerecg

1. 50x70 cm resim kagidi
2. Cizim kalemi

3. Silgi

4. Cetvel

Asagidaki islem basamaklarini dikkate alarak hayali bir iriin icin ambalaj eskizi
ciziniz.
islem Basamaklari
1. Atdlye 6nlugunizi giyiniz; ara¢ gerecinizi, calisma alaninizi is saghgi ve gu-
venligi tedbirlerini alarak 6zenle hazirlayiniz.
2. Ogretmeniniz ile bir rlin belirleyiniz ve bu Griin icin bes farkli ambalaj eskizi
ciziniz.
3. Arkadaslarinizla beyin firtinasi yapiniz, fikirlerinizi birbirinizle paylasarak
yardimlasginiz.
Ambalaj eskizlerinizi resim k&gidina ¢iziniz.
Ambalajinizin agik ve kapali halini planlayip ¢iziminizi yapiniz.
Kesim ve kirim yerlerini belirleyerek ciziniz.
Eskiz cizimlerinizi arkadaslariniz ve égretmeninizle paylasarak fikirlerini aliniz.
Eskiz cizimlerinizi sonra kullanmak Uzere dosyanizda 6zenle saklayiniz.
Planli ve disiplinli calismaya 6zen gdsteriniz.
10 Calismaniz bittikten sonra calisma ortaminizi temizleyiniz.

© o N Ok

Degerlendirme

Uygulama galismanizin suresi 6gretmeniniz tarafindan belirlenecektir. Calismaniz, 1.
Ek’te verilen “Ambalaj Maketi Hazirlama Degerlendirme Formu” veya “Ambalaj Ma-
keti Hazirlama Kontrol Listesi’ndeki Olcitlere goére degerlendirilecektir. Calismanizi
yaparken bu 6lc¢utleri dikkate aliniz.

anttim Grafigl
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4.2.4. Pencereli Ambalaj Maketi Hazirlama

Kutu ambalajinda pencereli tasarimlar da mevcuttur. Pencereli ambalajin yapim asamalari sun-
lardir:
* Tasarimi yapilacak Urtiine benzer Grlnler icin tasarlanmis pencereli ambalaj drnekleri
incelenerek sektdr analizi yapilir.
e Uriiniin taginmasi icin uygun malzeme segilir.

® Eskiz cizimleri yapilarak, trin i¢in en dogru ambalaj eskizi secilip ¢izim yapilir (Gorsel 4.34).
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Gorsel 4.34: Maketin acik ve kapal halinin ¢izimi

125




anttim Grafigl

37>ME’>ALAA MAKET FAZIRLAMA

Maket hazirlama islemine baslanirken dlciiler, triine uygun bir sekilde belirlenir. Olciiler, be-
lirlenip cizilirken 1 mm’lik hata bile ambalaj maketinin son asamasinda problem olugturur. Bu
sebeple olcilerin titizlikle yapilmasi énemlidir.

.
Y|

Gorsel 4.35: Cizim asamasi

Maketin olusturulacagi yizey sabitlenerek malzemenin kaymamasina dikkat edilir.

Maketin acilimi yizeye cizilir (Gorsel 4.35).

Maketin kesim ve kirim yerleri pencerenin kullanilacagi alan belirlenerek yizeye cizilir.
Ambalaj acihminin ¢izimi bitirildikten sonra &lctlerin dogru bir sekilde ¢izilip cizilmedigi kontrol

edilir.
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Ylzey kesim cizgileri takip edilerek kesilir. Diiz kenarlar icin maket bigagi, oval kenarlar igin
makas tercih edilmelidir. Pencere bélimaniin kesim islemi maket bicagi ile yapilir (Gérsel 4.36).
Kinm yerleri icin keskin olmayan sert bir cisimle iz birakacak sekilde kirim iglemi yapilir.
Yapistirma kulaklari olarak belirlenen bélimler yapistirici tagiriimadan yapistirilir (Gorsel 4.37).
Maketin kapak kilit sistemleri de kullanilarak maket, yapistirma kulaklarindan birlestirilir ve
makete son hali verilir (Gorsel 4.38).

1
[l
1
i
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1
1

]
1
1
1
1
1
L
1

Gorsel 4.36: Kesim ve kirm asamasi

Gorsel 4.37: Yapistirma asamasi Gorsel 4.38: Ambalaj maketi

anttim Grafigi
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OGRENME BiRiMi: AMBALAJ MAKETi HAZIRLAMA
UYGULAMA ADI : Kutu Ambalaj Eskizi Yapma

AMAC : Ambalaj tasarimi icin maket yapmak.
Arac Gerec

1. Kalin gramajli resim kagidi

2. Cizim kalemi

3. Silgi

4. Cetvel

5. Makas, maket bigagi

6. Yapistinci

Asagidaki islem basamaklarini dikkate alarak hayali bir triin icin pencereli ve
separatoérlii ambalaj maketi hazirlayiniz.

islem Basamaklari

1. Atélye 6nligunizu giyiniz; arag¢ gerecinizi, galisma alaninizi is saglig1 ve gu-
venligi tedbirlerini alarak 6zenle hazirlayiniz.

2. Ogretmeninizle birlikte hayal bir (iriin belirleyiniz, bu @iriine uygun kutu ambalaj
olusturmak icin arkadaslarinizla fikir aligsverisinde bulunarak eskiz ¢izimleri ya-
piniz.

3. Eskiz calismalarindan birini 6gretmeninizle birlikte secerek c¢iziniz.

4. Zamaninizi verimli kullanmaya, sabirli ve 6zenli calismaya dikkat ediniz.

5. Calisirken oturma pozisyonunuza dikkat ediniz, yanhs oturus sekli saghginiz
icin zararlidir.

6. Maketin olusturulacagi yuzeyi sabitleyerek malzemenin kaymamasina dikkat
ediniz.

7. Maketin agilimini ylzeye ¢iziniz.

8. Maketin kesim ve kirim yerlerini ylizeye ciziniz.

9. Ambalaj aciliminin ¢izimini bitirdikten sonra ¢iziminizi inceleyiniz.

10. Yuzeyi kesim ¢izgilerini takip ederek kesiniz.

11. D0z kenarlar icin maket bicagi, oval kenarlar icin makas tercih ediniz.

12. Kirim yerlerini keskin olmayan sert bir cisimle iz birakacak sekilde belirleyiniz.

13. Yapistiriciyl tasirmadan kullanmaya dikkat ediniz.

14. Yapistirma kulaklarindan birlestirip makete son halini veriniz. Ug boyutlu kutu
ambalajinizi olusturarak 6égretmeninize teslim ediniz.

15. Calismaniz bittikten sonra ¢calisma alaninizi temizleyiniz.

Degerlendirme

Uygulama c¢alismanizin siresi dgretmeniniz tarafindan belirlenecektir. Calismaniz,
1. Ek’te verilen “Ambalaj Maketi Hazirlama Degerlendirme Formu” veya “Ambalaj
Maketi Hazirlama Kontrol Listesi’ndeki 6l¢itlere gére degerlendirilecektir. GCalisma-
nizi yaparken bu olcitleri dikkate aliniz.
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OLCME VE DEGERLENDIRME

A) Asagida verilen ciimlelerin basindaki parantezlere climleler dogru ise “D”, yanls ise

“Y” yaziniz.

1.

wmn

4.

() Uriin ambalaji, nakliye tcretini ve Griin fiyatini gereginden fazla etkileyecek mali-
yette olmahdir.

() Satis ambalaji, dogrudan hedef kitleye ulagan ambalajdir.

() Taze meyve, sebze satisinda plastik ambalaj kullanilir.

() Metal ambalajlar sert sartlarda Gran0 korur.

B) Asagida verilen ciimlelerde yer alan bosluklari uygun ifadelerle doldurunuz.

5.
6.

7.
8.

9.

Ambalaj cesitlerinden ..............c.cooiiin saglga zararli oldugu icin dezavantajlidir.
Is1 ya da basing etkisiyle yumusatilhp kaliba dékme islemiile .................ccon.
ambalajlara farkl sekiller verilebilir.

Kagit ambalaj sekillerinden biride ..o, ambalajdir.

Silis kumunun cesitli katki maddeleri ile ylksek sicaklikta eritiimesiyle ........................
ambalalar olusturulur.

Ambalaj tasarimi sade ve ..., olmalidir.

C) Asagida verilen sorularin dogru cevaplarini isaretleyiniz.

10. Asagidakilerden hangisi katlama isleminin diizgiin ve kolay yapilabilmesi icin ambalaj

11.

acihminda belirlenen yerlerden ezme iglemidir?
A) Kilit sistemi

B) Pencere

C) Perforaj

D) Pilyaj

E) Separatér

Asagidakilerden hangisi Griin ambalaja yerlestirildikten sonra kapagin rahat acilip kap-
anmasi igin gerekli olan bélumdur?

A) Barkod alani

B) Gorsel tasarim

C) Kilit sistemi

D) Pencere

E) Yapistirma payi

D) Asagida verilen sorularin cevaplarini noktali yerlere yaziniz.
12. Pencereli kutunun tercih edilme nedenlerini yaziniz?
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AMBALA]J
UZERI

DUZENLEME

KONULAR
5.1. AMBALAJ ESKizi
5.2. BILGISAYARDA AMBALAJ TASARIMI

NELER OGRENECEKSINiz?

* Ambalaj uzeri diizenleme 6geleri

* Ambalaj tasariminda dikkat edilecek noktalar

* Hazirlanan eskize yonlerine dikkat ederek ogeleri
yerlestirme

Ambalajin ac¢ik halini ¢cizme

Bicak, kesim ve kirim yerlerini belirleme

Pencere veya ayracin yer ve Olclisinu belirleme
Deneme baskisi alarak tic boyutlu maket hazirlama

TEMEL KAVRAMLAR
o kirhm + kesim s pencere

HAZIRLIK CALISMALARI

1. Satin aldiginiz bir Griiniin ambalajinda genelde nelere
dikkat edersiniz?

2. Satin aldiginiz uriinler arasinda en ¢cok begendiginiz
ambalajin 6zelliklerini arkadasglarinizla paylasiniz.



e A Uzeri vizenLene

5.1. AMBALAJ ESKizi

Gelisen gorinti isleme ve tasarim programlari, gorsel iletisimin Snem kazanmasini saglamis; in-
san algisini ve davraniglarini da etkilemeye baglamigtir. Ginimuzde iletisim, yazidan ¢ok gérsel
izleme ile gerceklesmektedir.

Uriinlin piyasada tutulmasi; dogru ve etkili ambalajin secimine, tasarimina baghdir. Kolaylikla
algilanabilmesi icin Grinun markasi, barkodu, uyari isaretleri, tanimi ve ¢esidi gibi bilgiler ambalaj
Uzeri grafik tasarimin gérsel kismini olusturur. Burada amag, trtinin hedeflenen kitle icin ¢ekici
olmasi ve satisinin saglanmasidir. Ambalajin degismeyen 6geleri; marka logosu, icerik bilgisi,
son kullanma tarihi, Gretici firma bilgileri ve barkottur.

5.1.1. Ambalaj Uzeri Diizenleme Ogeleri

Marka: Paketin Gzerinde kullanilan marka ismi; markay tanimlama, hatirlatma ve Grlin bilgisi ver-
mekle sorumludur. Uriiniin bulundugu anda ve gelecekte tutulmasi, aranmasi igin marka isminin
bicimsel bir ézellik kazanmas gerekir. Ozgiin tasarlanmis marka kimligi tiiketicilerin zihninde yer
eder. Marka; amblem, logo ve logotype olarak kullanilabilir. Amag, akilda kalicilik ve trtin 6zellik-
leriyle értiisme olmalidir.

(4
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Goérsel 5.1: Amblem, logo, logotype 6érnekleri

132




AMBALAY 1ZER] DUZENLEME—N————

Metin: Metinler GrinlG tanimlayan ve Grtiin hakkinda cesitli bilgiler veren kismi olusturur. Metin,
Urtin hakkinda belirli bilgileri vermelidir. Paketin boyutlarina bagl olarak farkli puntolarda yazilabi-
lir, Ambalajlardaki metinler birka¢ saniyede tiketiciye gerekli bilgiyi vermelidir. Ambalaj icinde ne
tar bir Grdn oldugu, tranun ézellikleri ambalaj Gzeri tasarimla misteriye sunulur. Bunlar ilgi ¢ekici
olmazsa urtnun satisini etkileyebilir. Bu nedenle sézcuklerin bicimlenmesi, diizenlenmesi profes-
yonelce tasarlanmalidir. Ambalaji yapacak grafik¢inin tipografi bilgisinin olmasi gerekir.

Ambalaj tzerinde marka tanimini, Urtn tanitimi ve 6zelliklerini aktaran metinler disinda kanuni
zorunluluk tasiyan metin bélumleri vardir.

® Satin alinan Urinin ambalajina gére tutus yénlne, acilmasi, hazirlanmasi ve saklanma-
sina ait bilgiler

® Yiyecek ve icecek tlrl ambalajlarda tlketiciyi beslenme konusunda aydinlatan bilgiler ve
Uranun besin degerlerini aciklayan metinler

* ilag kutularinda ilacin kullanim sekli ve etkilerinin, uyarilari ve doz ayarlamalarinin oldugu
metinler

¢ Kimyasal trGnlerde Urinun tagsinma sekli, saklanma kosullari ve uyarilarla ilgili metinler

e Uriin icerigi, gramaji, net agirlik bilgileri ve adedi ile ilgili metinler

BESIN DEGERLERI (100g igin)
Protein % 57
Yag 81

e 8l 8093

Gorsel 5.2: Aciklama metinleri, barkod

) —

070123

Renkler: Ambalajda kullanilan fon rengi, fonun bir kismina hakim olan renk, Grinin ¢esidine
dikkat ceken renk veya fotograf ve illistrasyonda kullanilan renkler Griniin sunumunda 6nem arz
eder. Bu nedenle tasarimcinin renk bilgisi olmali, tasarimci renklerin psikolojik etkilerini bilmelidir.
Rengin daha islevsel bir boyutu, Uriin kategorisi ve farklilasmasinda kullaniimasidir. Tuketiciler
bazi renklerin verdigi mesaja o kadar alismistir ki belli Griin gruplarinin, bazi tatlarin, cinsiyetin,
kalitenin belirlemesinde hep bu renkler kullanilir. Bunun en guzel érnegi, kozmetik Urtnlerinde
erkekler ve kadinlar igin farkli renk segeneklerinin kullaniimasidir.

Yuzeydeki tek renk veya bir rengin tonlarinin egemenligi gérsel etkiyi gug¢lendirir. Ambalajdaki
yazi ve bicimler, zemin rengiyle karismamalidir. Renk kullaniminin en dogru sekli, ambalajin
icindeki driini temsil etmesidir. Ornegin renkli boya kalemleri, kozmetik driinler, matbaa miirek-
kepleri ve boyalarin ylzeyinin bir kismi Griintn igindeki renklerle baglantili kullanilir. Ayrica ekran
renginin baskida farkl bir renk olacagi unutulmamaldir. Baski alinacak makinanin renk degerleri,
dogru analiz edilmeli ve tasarim yapilan bilgisayarin renk ayarlari ile uyum icinde olmalidir.
Sonug olarak baskida hangi renkle kargilasilacag: iyi bilinmelidir.

anttim Grafigi
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COCONUT

You text here

You text here

CHOCOLATE

Gorsel 5.3: Ambalajda renk kullanimi
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Gérseller: Uriin hakkinda bilgi vermenin en etkili yolu, ambalaj tizerinde fotograf veya illiistras-
yon kullaniimasidir. Ambalaj Gzeri gérsellerin kullanim amaclari sunlardir:
e Urin farkliliklarini belirtmek veya kullanim énerisi yapmak
e Uriindn iglevini géstermek, modiiler bir Grintn kurulum asamalarini gdstermek, bir ya-
pistirma malzemesinin kullanimini veya bir yiyecek Urininin hazirlanmasini tarif etmek
® Duygusal bir cekim saglamak

® Ambalajin igindeki Grtiniin son halini gdstermek

Fotograf ve illustrasyon, belirli bir beceri ve disiplin gerektiren alanlardir. Bunlari farkli sekillerde
kullanarak insanlar tzerinde degisik duygu ve disunceler olusturmak mimkindir. Fotograf ya
da illustrasyon sec¢imi tasarimcinin kendi kararidir. Bu tercih; konu, triin goérseli, Grin lgekle-
ri, amacglanan mesaj, maliyet, baski teknigi ve tasarimin suresi gibi degisik sartlardan etkilenir
(Gorsel 5.3, 5.4).

anttim grafigi

Gorsel 5.4: Ambalaj tizerinde kullanilan gérsel 6rnekleri
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e A Uzeri vizenLene

Semboller: Bir kavrami temsil eden somut bir sekil, nesne, isaret, s6z ya da bir hareket olarak
aciklanabilir. Semboller kullanilarak yapilan iletisim, diger dogrudan iletisim bigcimlerine gére ¢ok
daha farkli, derin ve algilama seviyelerine gére daha yiksektir (Gérsel 5.5). Uriin ambalajlari,
kelimeler ve renklerle oldugu kadar sembolik anlatimlarla da tiketiciler ile iletisim kurar. Ginimuz
tuketici egilimleri cercevesinde goérsel iletisimin 6Gnem kazanmasi, sembollerin kullaniimasina du-
yulan ihtiyaci da artirmaktadir. Semboller, birgok anlami barindirabilen gérsel ézellikleri ile bilgi
alisverisini hizlandirir. Bu dogrultuda ginimizde daha ¢ok Uriin ambalajinda cesitli bicimlerde
gorsellestiriimis sembollerin kullanildigi gérilmektedir.
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Gorsel 5.5: Ambalaj Uzerinde kullanilan semboller

5.1.2. Ambalaj Tasariminda Dikkat Edilecek Noktalar

Gunimiizde birgok marka belirli bir Girinii iretmekte ve benzer sekillerde pazarlamaktadir. Uriiniin
tasarimi, satisa ve pazarlamaya dogrudan etki etmekte ve rekabet farki yaratmaktadir. Bu neden-
le ambalajda grafik tasarimi, satisa sunulan Griiniin tim ézelliklerini yansitmalidir. Urliniin piyasa-
da taninabilmesi, bir yer edinerek satis yapabilmesi dogru ve etkili bir ambalaj malzemesinin se-
cimine ve tasarimina baghdir. Urlinlin yapisina uygun segilen renkler ve bu renklerle uyumlu yazi
ve bicimlerle tasarlanan ¢ekici, gizel gériinimli ambalaj musteriyi etkiler. Ambalaj tasarimi, Griin
hakkinda bilgi verirken (riiniin karakterini yansitir. Uriin, tiiketicisine dogrudan ambalaj ile sesle-
nebilir. Dolayisiyla ambalaj bir reklam olarak kabul edilmelidir. Bulundugu rafin éniinden gecen
tiketiciye birka¢ saniyede kutunun icinde ne oldugunu ve kalitesini mesaj olarak iletebilmelidir.
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Ambalaj tasariminda marka etrafinda bir btinlik olusturulmalidir. Zamanla marka ve ambalaj

battunlesmeli, akillarda yer etmelidir. Grafik tasarimci, ambalaj tasariminda sadece estetik kaygi-
lari degil, sirketin pazarlama politikasini ve kultirel gereklilikleri de g6z éniinde bulundurmalidir.
Satis noktalarindaki Griin diziminde paketin 6n yizl her zaman gériinmeyebilir. Bu nedenle am-
balajin yan ve st yizeyleri de Urln tanitimi icin énemlidir.

Urlin ambalajinda Griinle tasarim 6geleri arasinda saglam bir iliski kurulmalidir. Ambalajin rengi,
secilen yazi ve bicimler, bunlarin diizenlenmesi uyumlu olursa goérsel etki glcli olur. Bu da tluke-
ticinin zihninde olumlu bir imaj yaratir.

Ambalajda renk secerken tuketicinin dusunceleri, duygulari, bdélgesel ve kdltirel algilar goéz
Ondnde bulundurulmalidir. Farkh kdltdrlerde renkler ve kullanilan gorseller degisik algilar olus-
turabilir. Yurt digi pazarlarina sunulacak Urlnlerin ambalaji buna uygun tasarlanmalidir. Ambalaj
rengi, Urin yapisi ile bagdagmalidir. Bulunmasi zorunlu yazilar, 6nem sirasina gére ve agirlkl
olarak gorulebilecek ylUzeylerde kullaniimalidir. Karsilikli ylzeylerde bicim ve yazilar tekrarlana-
bilir. Konserve gibi silindir ambalajlara belirli bir noktadan bakildiginda ambalajin sadece Ugte biri
gorulebilir ve dortte biri okunabilir durumdadir. Yassi ambalajlarda alt kisimlar, fazla énemli olma-
yan bilgiler veya Uriini aldiktan sonra okunacak konular icin kullanihir. Ambalajin Ust kisminda
marka, sirket ismi, ayirt edici 6zellikler gibi asil bilgiler yer almahdir.

Farkli Ulkelerde farkli gdrsel algilar olabilir. Bunlar tarihi ve kiltlrel birikimlerin sonucudur. Bu
sebeple satigi uluslararasi yapilacak bir Grintin ambalaj tasarimlarinda bélgeye gére degisiklikler
olmaldir. Avrupali tiiketiciler belirgin olarak daha 6zellesmis tercihlere sahiptir. Avrupalilar paketin
icindeki Uriin ile ilgili daha fazla bilgi edinmek ister. Uriiniin icerigi ile ilgili aciklamada ve kullanim
talimatinda kesin bilgilerin bulunmasini istenir. Ayni zamanda ambalajlarin daha dayanikl olmasi
ve ikinci kullanim sansinin olmasi genel olarak ¢ok tercih edilir. Estetik tasarimlara énem verilir.
Farkl Ulkelerde tercihler degisebilir. TUketiciler dayanikli ambalaja fazla para 6demek istemeye-
bilir, ucuz ve dayanikh olmayan ambalajlar tercih edilebilir. Genel olarak ¢ok uluslu bir firma, ulus-
lararasi pazarlarda ambalajini kaltirel farklihklara dayanan algilamalara yonelik tasarlayabilir.

Ozellikle uluslararasi pazarlarda kabul edilemeyecek anlamlara sahip sembollerden kaginmak
gerekir. Yazi cevirilerinde dikkatli olunmalidir, ¢eviri sirasinda olugabilecek anlam kaymalarindan
sakiniimaldir. Sembol gibi ambalajin rengi de dikkatle secilmelidir. Kultirler arasinda renklerin
psikolojik etkileri farklilik gésterebilir.

5.1.3. Ambalaj Eskizi Hazirlama ve Eskize Ogeleri Yerlestirme

Ambalajin satis araci olarak verimlilige katki saglayan islevleri vardir. Uriinii korumakla ve nak-
liyesini, dagitimini, teshirini daha kolay hale getirmekle kalmaz; GrGnin pazarlanmasi igin kritik
fonksiyonlari da yerine getirir. Urliniin rakip Uriinler arasindan siyrilmasina yardim eder. Uriiniin
tiketici tarafindan taninmasini saglayacak marka ve driin kimligini olusturur. Urlinii cazip ve dik-
kat cekici sekilde sunar. Uriin hakkinda tanimlayici bilgileri ve 6zellikleri gésterir. Uriin gesidini,
ebatlarini, farkli tatlari ve diger 6zellikleri aktarir. Ambalaj; acilmasi, kapanmasi, tasinmasi, sak-

anttim Grafigi

lanmasi ve tiketilmesi gibi yonlerden GrtnG kolay bir bicimde sunar.
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Yapisal tasarim, tlketicinin duygularina hitap eden goérseller yaratirken grafik tasarim, Griinin
satin alinmasini etkilemek icin firsatlar yaratir. Bunu saglamak icin ambalaj grafigi, Grinin tim

Ozelliklerini en gucli ve anlasilir sekilde ifade etmelidir. Ambalajda kullanilacak gérsel, hem tasa-
rimciya hem Urtn sahibine hem de tiketiciye hitap edebilmelidir.

Ambalaj hazirlarken bazi sorularin cevaplari dastuntlmelidir:
* Ayni Urinu satan bagka sirketlerin Grtnlerinden tlketicinin bakisi nasil ¢ekilebilir?
® Tasarimi yapilan ambalaj nasil farkl ve 6zgun olabilir?
*  Uriinin avantajlari nasil kullanilabilir?
* Grafik gorselleri, rakip trtnlerin kullanmadig sekilde nasil kullanilabilir?

Ambalaj Gizerinde bulunmasi istenen genel veriler gunlardir:
* Marka kimligi
e Urin adi
e Urinan tanimi
* Tat ve cesit 6zellikleri
* Fayda cumlesi
* Satis metni
®* Promosyon mesaji
* Kullanim tarifi
® Bagska Uriin veya cesitlere atif
® Yiyecek Urtnlerinde beslenme degerleri
* lag ve kimyasal Uriinlerde uyarilar
* Ebat ve igerik

Bunlarin disinda tasarimci sonu olmayan grafik ve yazi ile tasarimini yapabilir (Gorsel 5.6).

icindekiler

~ Besin degeri

:_ Vitamin degeri

A Saklama kosullari
-

=
&
S
~
S
£
5
S
=

Gorsel 5.6: Ambalaj tzerinde kullanilan égeler
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| Etkinlik

Goérsel 5.7’yi inceleyiniz. Siz de farkl bir gida

drininiin ambalajini birlesim yerlerinden
h 6zenle, yapisini bozmadan acarak resim ka-
gidina ciziniz. Yazi, gérsel ve metin alanlarini
belirleyiniz. Calismanizi kuru boya, sulu boya
veya serbest teknikle renklendiriniz. Yazi ve
metin kisimlarini 6l¢ii alarak bos birakiniz.

arka temizle

Gorsel 5.7: Ambalaj

Eskiz Hazirlarken Dikkat Edilmesi Gereken Noktalar
Yeni bir ambalaj hazirlanirken 6ncelikle benzer Griinlerin am-
balajlarinin incelenmesi faydali olur. Benzer Urlnlerden nasil
bir farkla ayrilabilecegdi, benzerinden pahali veya ucuz olmasi-
nin nasil avantaja gevrilebilecegi gibi konular lzerinde fikirler
uretilmelidir. internet ve basili yayinlar incelenmeli, televizyon
reklamlari takip edilmelidir. Ambalaj tasarimi yapilacak Urin
hakkinda veriler toplanmaldir. “Uriin ne icerir? Ozellikleri ne-
dir? Hangi yas grubuna hitap eder? Uluslararasi pazarlarda sa-
tis1 yapilacak mi1?” sorularina cevap aranmaldir. Gerekli bilgiler
toplandiktan sonra taslak cizimler yapiimalidir.

Taslak calismalari icin kullanilacak fotograf ya da illistrasyon-
lar, Griin logosu ile birlikte hazirlanarak renklendiriimelidir. illiist-
rasyonlar farkli boyama teknikleri ile elde yapilabilir. Daha son-
ra fotograflar icin gérinta isleme programi; illistrasyonlar, yazi
ve diger cizimler icin vektdrel tasarim programlari tercih edilir.
Ambalajin sekline karar verildikten sonra acgik héli k&gida cizi-
lir. Gorseller ve diger elemanlar taslak olarak yerlestirilir. Grafik
programlari yardimiyla hazirlanan taslak, orijinal héline getirile-
rek kinm ve kesim yerleri belirlenir. Baskiya hazir hale getirilir.

anttim Grafigi
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Konsept calismasi: Tasarimi yapilacak (iriiniin tiim cesitleri icin tasarimin disiiniilmesidir. Orne-
gin bir gida firmasinin bisklvi, gofret, cikolata vb. Grinleri icin ambalaj tasarimi ¢alismasinin plan-
lanmasi konsept calismasi olarak isimlendirilir. Konsept belirleme asamasinda trinun ézellikleri
ve hangi 6zelliklerle satisa sunulacagi miisteriden 6grenilmelidir. Urlin yeni mi ¢ikacak yoksa
Uriin ambalajinda yenileme mi yapilacak gibi sorularin cevaplari, farkl istek ve éneriler, tasarim-
dan 6nce musteriden alinmaldir.

Piyasada var olan bir Griin icin hazirlanan ¢alismalar iki bicimde tasarlanabilir.

* Mevcut tasarimin devami niteliginde olmalidir.
®* Tamamen farkli, 6nceki tasarimdan hicbir iz tasimayan, yeni bir hedef kitleye yonelen
calisma olmalidr.

GREEN TEA

100% ORGANIC

WHITE TEA

Gorsel 5.8: Ambalajlarin farkh tasarimlari

Secilen konsept ana marka kimliginin altinda bir alt marka logosu kullanimi gerektiriyorsa alt
markanin ana markayla ve kurum kimligi ile iligkisi dogru tanimlanmalidir. Uriin gérsellerinin et-
kili kullaniimasi igin kapsamli bir aragtirma yapilmasi gerekir. Uriin ézelliklerini anlatan cimleler,
baslangicta yoksa veya degistirilecekse tasarimda da degisiklik yapilabilir. Bu durumda marka
ve Urdn kimligi, trdn tanimlamasi, renkler, Griin sunumlari ve diger elemanlar icin tekrar tasarim
gerekebilir. Planlama bu dogrultuda yapilmahdir.

Ambalaj tasariminda ambalaj maketinin mutlaka kullaniimasi gerekir. Tasarimin ¢ boyutlu duru-
su, gercek goéruntlyu olusturur. Maket hazirlamak icin farkli malzeme de kullanilabilir. Ambalajda
kullanilan etiket, genellikle yizeyin %40’ini olusturur. Konsept calismasi ve maket uygulamalarin-
dan sonra baski agamasina gegilebilir.
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1014015 sfcsw.’l

2. Etkinli

gor-

sel, renk ve metin alanlarini degistirerek farkli bir tasarim yapiniz. Calismanizi

)

Gorsel 5.9’u inceleyiniz. Siz de Sekil 5.1’in icine liriin ambalajinin yazi

sulu boya veya serbest teknikle renklendiriniz.

kuru boya,

Gorsel 5.9: Ambalajin acik hali

)

Sekil 5.1
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OGRENME BiRiMi: AMBALAJ UZERIi DUZENLEME
UYGULAMA ADI : Ambalaj Eskizi Yapma

AMAC : Ambalaj Gzeri diizenlemeleri igin elle eskiz calismalari
yapmak.
Arac Gerecg
1. Karton, kagit vb.
2. Cizim kalemi
3. Cetvel
4. Silgi
5.

Kuru boya, sulu boya vb.

Asagidaki islem basamaklarini dikkate alarak, iiriin ambalaji belirleyip es-

kizler hazirlayiniz.

islem Basamaklari

1.

8.
9.
10.

Atdlye 6nlugindzi giyiniz; arag gerecinizi, calisma alaninizi is sagligi
ve glivenligi tedbirlerini alarak 6zenle hazirlayiniz.

Tasarim igin bir Grtin secerek Urtine uygun bir ambalaj belirleyiniz.
Urlin ambalaji icin belirlediginiz malzeme (kagit, karton vb.) Gizerine
cetvel yardimiyla ambalajin agiimis halini ¢iziniz.

Calisirken oturma pozisyonunuza dikkat ediniz, yanlis oturus sekli sag-
hginiz igin zararhdir.

Yazi, gérsel ve metin alanlarinin yerini dlgcerek belirleyiniz.

islemleri tekrarlayarak farkl eskizler hazirlayiniz.

Eskizlerden birini segerek kuru boya, sulu boya, renkli kalemlerle ya da
farkli bir teknikle eskizi renklendiriniz.

Zamaninizi verimli kullanmaya dikkat ediniz.

Metin alanlarini ince uglu kursun kalem ya da tikenmez kalemle yaziniz.
Bitirdiginiz calismanizi temiz bir dosyada saklayiniz.

Degerlendirme

Uygulama calismanizin slresi 6gretmeniniz tarafindan belirlenecektir. Calis-

maniz,

1. Ek’te verilen “Degerlendirme Formu” veya “Kontrol Listesi’ndeki

Olcutlere gbre degerlendirilecektir. Calismanizi yaparken bu 6lgutleri dikkate

aliniz.
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5.2. BILGISAYARDA AMBALAJ TASARIMI

Ambalaj Uzeri tasarimi, eskiz olarak hazirlandiktan sonra vektérel programa aktarilir (Gérsel
5.10). Programa aktarma islemi farkli bicimlerde olabilir. Tasarimci programi kullanma alis-
kanhklarina gére degisik uygulamalar yapabilir. Degismemesi gereken kural; 6l¢llerin hatasiz,
kesim ve kirim yerlerinin dogru belirlenmis olmasidir.

Uygulamalardan birinde eskiz calismasinin fotografi ¢ekilerek fotograf programa aktarlr. Fo-
tograf sayfaya 0Olclsline gore yerlestirilerek layer acgilir ve gorsel saydamhigi (opacity) %60-%40
olarak dusuruldr ve kilitlenerek Gzerinde caligiimaya baglanir. Ambalaj élctstinden buyuk bir say-
fa acilir. Cetvel ve grid cizgileri acilarak milimetrik, hatasiz olarak dis hat ¢izimi yapilir. Bunun
Uzerine illistrasyon veya fotograf yerlesimleri yapilarak tasarim surduralar. Fotograflarin dizen-
lenmesi goruntl duzenleme programinda yapilir.

Name:

Profile: ' [Custom] -

Number of Artboards: = FINNEEEN

Units: | Millimeters

G 210 mm. | Orfentation: 'Yy Y

Top Bottom Left Right

Bleed: = EXLUMN =

anttim Grafigi

Gorsel 5.10: Sayfa agma
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5.2.1. Ambalajin Acik Halini Vektérel Programda Cizme

Genel olarak énce bicak kesim ve kirim ¢izgilerinin oldugu sablon ¢izimi, sonra tasarim yapilir.

Vektorel programda sablon dlctistinde bir sayfa agilir. Bicak kesimi yapilacak yerler devamli ¢izgi;
kirim yapilacak yerler kisa, kesik noktali ¢izgi ile gésterilir (Gérsel 5.11).

Gorsel 5.11: Programda ambalajin agik halinin gizimi
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\____/ Gérsel 5.12: Kinm, kesim yerlerinin cizimi

Dis hat veya sablon cizimi bitirilince tasarim kismina gegilir. Onceden hazirlanmis eskizlerden
secim yapihr. Gizim, renklendirme, bicim verme araclar ve Degrade, Gradient, Effect se¢imleri
gibi sonsuz secenekler uygulanarak eskiz gérintisu olusturulur. Kullanilacak fotograflar, gérinti
isleme programinda diizenlenir ve vektorel programa aktarilir. Metin kisimlari yazilir, zemin dolgu
renkleri verilir (Gorsel 5.12).

anttim Grafigi

145




antttm Grafigi

e A Uzeri vizenLene

5.2.2. Bicak, Kesim ve Kirim Yerlerini Belirleme

Ambalaj tasariminin sonunda kesim ve kirim yerlerinin belirlenmesi gerekir. Baski islemi tamam-
landiktan sonra ambalaj malzemesinin kesim ve kirim igslemlerinin yapilma asamasi gelir (Gorsel
5.18). Bu islemlerin yapilabilmesi icin 6zel bicaklar yaptiriimasi ve kirrm makinasinin ayarlan-
masi gerekir. Bu nedenle tasarimi yapan Kkisi kesim ve kirim yerlerini belirler ve ayri bir sablonda
gOsterir (Gorsel 5.14).

Lorem &Jum

Gorsel 5.14: Ambalaj sablonu
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5.2.3. Pencere ve Separator

Bazi ambalaj tirlerinde ambalaj icindeki urin gosterilmek istenir. Bu nedenle ambalajin bir kismi
saydam malzeme ile yapilabilecegdi gibi o alan icin bosluk da tasarlanabilir. Pencere uygulana-
caksa bunun tasarima ve kesim, kirim sablonuna eklenmesi gerekir. Acma veya ayirma iglemi bir
diger sekilde delikli olarak hazirlanir. Bu sekil; bilet, fatura gibi kopartilarak ayrilacak lrlinlerde daha
cok kullanilan bir tasarimdir. Bu isleme perforaj denir. Perforaj makinesi, kesme ve kinm makine-
sinden ayr bir islem yapar. Perforaj cizgilerinin sablonda gosterilmesi ve tasarim planinda bulundu-
rulmasi gerekir. Aksi halde delikli kisimlar tasarimda ¢irkin gérlntilere sebep olabilir. Separatoérler;
ambalajla Grin arasina yerlestirilen, carpma ve dismelere kargi Urliniin zarar gbérmesini engelle-
yen bélimdar. Uriiniin hassasiyet 6zelliklerine gére tercih edildigi icin her ambalajda kullaniimaz.

anttim Grafigi

Gorsel 5.15: Pencereli ambalaj
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5.2.4. Deneme Baskisi ve Ambalaji Olusturma

Taslak hazirlandiktan sonra varsa gerekli inceleme ve dizeltmeler yapilir, taslaga son sekli verilir.
Ambalajin yapisal tasarimi tamamlandiginda baskiya hazir hale getiriimesi icin ambalaj bilgisayar
ortamina aktarilir. Oncelik yapisal tasarim olmalidir, ambalaj (izeri tasarim daha sonra gelmeli-
dir. Yapisal tasarimda goérsel unsurlara yer verilimez. Bu ayni zamanda ambalajin kesim, kirim,
perforaj vb. dzelliklerini gdsteren bicak kalibi 6zelligini de tasir. Yapisal tasarim baski sonrasinda
ambajin kesimi icin bicak yapiminda kullanilir.

Yapisal tasarimi tamamlanan ambalajin grafiksel tasarimina gegilir. Grafik her bir ylizey 6lgtsiine
gbre ayri ayri tasarlanabilecegi gibi bitiin olarak da tasarlanabilir. Gérsel unsurlar yerlestirilirken
fotograf veya illistrasyonun kirim yerlerine denk gelmemesi gerekir. Tasarim plani dahilinde fo-
tograf veya illistrasyon kirim yerlerine denk gelecekse ¢irkin bir gérintt olusturup olusturmaya-
cagl deneme baskisinda takip edilmelidir. Ayrica caligsmaya tagsma paylarinin mutlaka verilmesi
gerekir. Tasma payi ambalajin biyuklugine gére degisiklik gésterebilir, standart uygulama 4 mm
olabilir. Tasma payinin verilmemesi halinde ambalajin kenar kisimlarinda istenmeyen beyazliklar
kalabilir (Gorsel 5.16).

Ll
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CholaBijss
with Myl Cream

DT e deg

Gorsel 5.16: Deneme baskisli
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5.2.5. Ambalaj Calisma Ornekleri
—

anttim grafigi

Gorsel 5.17
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Gorsel 5.18
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. Efkinlik ~

Gorsel 5.19’daki ambalajlar ile ilgili asagida verilen sorularin cevaplarini
noktali yerlere yaziniz.
1. Ambalajlar farkli renk ve gérsellerle tasarlanmistir. Size gére secilen renkler

ardin icin uygun mu? Neden?

2. Ambalaj tasarimi Griin hakkinda gerekli bilgiyi veriyor mu?
3. Ambalajlan siz tasarlyor olsaydiniz hangi renkleri kullanirdiniz? Neden?
4. Tasarim 6gelerinin yerlesimini degerlendiriniz.

Instant =
Fitanin Wheat Porridge v """° Instant =~ Yemne
Instant ~ Jmec dge ~namina Batmeal

VEalchum

[Porridge vcuim with chocolare

m | strawberry

Skl
&/

— e p- ¢
-i—u_ . b ...‘_,

M Instant ~ Yemne
! Oat meal N Caicum

with chocolate

raspberry

Gorsel 5.19: Farkli ambalaj tasarimlari

anttim Grafigi
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OGRENME BIRiMi: AMBALAJ UZERIi DUZENLEME
UYGULAMA ADI : Bilgisayarda Ambalaj Uzeri Diizenleme Yapma

AMAC

: Bilgisayarda ambalaj Gzeri dizenleme yapmak.

Aracg Gerec

1. Bilgisayar

2. Vektdrel gizim programi

Asagidaki islem basamaklarini dikkate alarak, elle yapilan eskizlerden

uygun olani bilgisayara aktarip ambalaj Gizerinde diizenlemeler yapiniz.

islem Basamaklari

1.

10.

1.

Atblye 6nligunizi giyiniz; arag gerecinizi, galisma alaninizi is saglhgi
ve glvenligi tedbirlerini alarak 6zenle hazirlayiniz.

Vektérel programda ambalaj boyutlarinda bir sayfa aginiz.

Ambalaj maketinin agilmig halinin dis gizgilerini milimetrik &l¢tlerine
dikkat ederek ciziniz.

Kirim, kesim ve perforaj yerlerini giziniz.

Calisirken bilgisayar ekranina 20-30 cm mesafeden fazla yaklasma-
maya ve sandalyede dik oturmaya dikkat ediniz.

Secilen eskiz dogrultusunda ¢izim, renklendirme, bicim verme islemle-
rini yapiniz.

Tasarimlarinizi yaparken belirli araliklarla kaydediniz.

Kullanilacak illustrasyon veya fotograflari gérinti isleme programinda
dizenleyerek vektdrel programdaki ambalaj tasarimina aktariniz.
Amblem, logo, urln adi, slogan vb. 6geleri eskize uygun sekilde yerle-
rine yerlestiriniz.

Ambalajda bulunmasi zorunlu olan metin kisimlarini yazip yerlerini
ayarlayiniz.

Calismaniza bir isim vererek kullandiginiz vektorel programin kendi
formatinda ve baskiya uygun formatta calismanizi kaydediniz, bir kla-
sOr olusturarak arsivleyiniz.

Degerlendirme

Uygulama calismanizin siresi 6gretmeniniz tarafindan belirlenecektir. Calis-
maniz, 1. Ek'te verilen “Degerlendirme Formu” veya “Kontrol Listesi’ndeki
Olcitlere gore degerlendirilecektir. Calismanizi yaparken bu oélcitleri dikkate

aliniz.
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OLCME VE DEGERLENDIRME

A) Asagida verilen climlelerin basindaki parantezlere ciimleler dogru ise “D”, yanhs ise
“Y” yaziniz.

1. () Uriiniin piyasada tutulmasi ambalaj secimine ve tasarimina baghdir.

2. ( )Ambalaj tasariminin degismeyen dgelerinden biri marka logosudur.

3. ( ) Ambalajtasariminda yalnizca firmanin amblemi kullanilir.

4. () Metin alani Griin hakkinda gesitli bilgiler veren kisimdir.

B) Asagida verilen ciimlelerde yer alan bosluklari uygun ifadelerle doldurunuz.

5. Kanuni zorunluluklar kismi, ambalaj Uzerinde ...............c.coveiiinnn. béliminde yer alir.
6. Ambalaj tasarimi yapilirken renklerin ..o, bilinmesi gerekir.
7. Ambalajin gorsel alaninda fotograf veya ..........c.cooiiiiiiiiininns kullantlir.

C) Asagida verilen sorularin dogru cevaplarini isaretleyiniz.

8. Asagidakilerden hangisi ambalaj tasarimi yapilirken kesim cizgilerini gésterir?
A) Devaml
B) Ince
C) Kalin
D) Kesik
E) Kesik noktali

9. Asagidakilerden hangisi ambalaj acilmadan trinin géralebilmesi icin kullanilan bolimdur?
A) Barkod alani
B) Gorsel tasarim
C) Metin alani
D) Pencere
E) Yapistirma payi

D) Asagida verilen sorularin cevaplarini noktali yerlere yaziniz.

10. Deneme baskisi neden yapilmalidir? Agiklayiniz.

anttim Grafigi
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OGRENME
® BiRiMi

RAPORTLAMA
TEKNIKLERI

KONULAR
6.1. TAM (DUZ) RAPORT SISTEMI
6.2. YARIM (SOTER) RAPORT SISTEMi

NELER OGRENECEKSINiz?

e Raportlama ile ilgili kavramlar
e Tam (diz) raportlama sistemine uygun motif hazirlama
e Yarim (soter) sistemine uygun motif hazirlama

TEMEL KAVRAMLAR

e raportlama
e birim motif
o aks

HAZIRLIK CALISMASI
Herhangi bir yuzey tizerinde tekrar eden amblem, logo veya
desen motifi dikkatinizi cekti mi? Ornekler veriniz.
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6.1. TAM (DUZ) RAPORT SiSTEMIi

Desen moatiflerinin enine, boyuna ve esit araliklarla tekrar eden en kiiguk pargasina raport denir.
Motiflerin yakinlik, uzaklik, buyuklik, renk, gruplanma gibi 6zelliklerinin farkh sekillerde diizen-
lenmesi islemine ise raportlama denir. Grafik alaninda raportlama, rlnlerin toplu halde paket-
lenmeleri esnasinda kullanilan ambalaj kagitlarinda, ambalaj kutusu zemin dlzenlemelerinde,
kaplama malzemelerinde ve siklikla tekstil Grinlerinde kullanilir. Raportlama yapilirken basilacak
ylzeye, bu ylizey malzemesine uygun basim yapacak makinenin ¢zelliklerine ve ylzeyin formuna
dikkat edilmelidir. Ornegin tekstil iiriinlerinde makinenin renk sayisina ve yiizeyin formuna uygun
hesaplamalar ile tasarimlar yapilmazsa hatalar olusur.

Siklikla kullanilan raport cesitleri, tam (diiz) ve yarim (soter) raporttur. Bunlar diginda diyagonal
raport, cevirme raport ve kapaklama raport sistemi de bulunur.

Gorsel 6.1: Raportlama

anttim Grafigl
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6.1.1. Tam (Duz) Raport Sisteminin Uygulama Asamalari

Amblem, logo veya desenden olusan birim motifin, enine ve boyuna siralanmasi ile olusturulan

raport sistemidir. Uygulamasi en kolay raportlamadir. Desenlerin tekrarinda herhangi bir kaydirma
yapilmaz ve desenlerin uygun bir sekilde birleserek yol olusturmasi beklenmez.

Gorsel 6.2: Diz (tam) raport

Raportlama iglemine baglamadan Once tekrar edecek olan birim desen motifi hazirlanmalidir.
Gorsel 6.2'de kirmizi gizgiler ile isaretlenmis dortli amblem dizenlemesi, birim motif olarak kulla-
nilmistir. Motifin; k&gidin cinsine, kullanim yerine ve baski yapilacak teknige uygunluguna dikkat
edilmelidir. Basima uygun renk modu kullanilarak renklendirilen birim motif, raportlamaya hazir hale
gelir. Raportlamaya uygun grafik programinda baskisi yapilacak yizey biyUkliginde bir dokiman
acilarak isleme baglanir. Ctrl+R kisayolu ya da View > Rulers > Show Rulers komutu ile cetvel
gobrindr hale getirildikten sonra kilavuz gizgileri yardimiyla akslar belirlenir.

anttim Grafigi
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Hazirlanan birim motif cogaltilarak yan yana ve alt alta kilavuz veya aks cizgileri yardimiyla Goérsel
6.3'teki gibi hizalanir. Cogaltma yapilirken, birden fazla birim motif secilerek kopyama islemi
hizlandirr.

Bl

©) & S &2 & 1B

$50G85S,

SO0
POEGRY:

Gorsel 6.3: Vektdrel programda tam (diz) raportlama

il@i kutucu

Vektorel tabanl programda meni gubugundan Object > Pattern > Make komutu
ile desen olusturularak da raportlama yapilabilir.

mesi yapiniz.

anttim Grafigi

. Etkinlik
Daha dnce calistiginiz bir amblem veya logoyu seciniz. Vektérel ta-
banl programda sectiginiz liriine uygun boyutlarda bir dosya aci-
niz. Tam (diiz) raportlama teknigine uygun ambalaj kagit diizenle-
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OGRENME BiRiMi: RAPORTLAMA TEKNIKLERI
UYGULAMA ADI : Bilgisayarda Tam (Dliz) Raport Yapma

G : Raportlamada kullanilacak deseni tam (diz) raport siste-

é ANIAG - Ir:‘ni:e gt<|'5re ye?pmkakl.I | “ t (i) raport st

_é_a Arac Gerec

= S98585:64)

—5 3. G[avfiktasarlm programiari @\é@\é@\é@\éf
5 Kalom SRGQERGQ
6. Cetvel @@@\Q@@@@’
7 Gane | AT ATy
(ote alarak raportiama aligmas FEAGEAY,
vapiniz AR AT

Gorsel 6.4:Tam raportlama teknigine uygun
ambalaj kagidi

islem Basamaklari

1. 1Atdlye 6nligindza giyiniz; ara¢ gerecinizi, calisma alaninizi is sagligi ve
guvenligi tedbirlerini alarak 6zenle hazirlayiniz.

2. Gorsel 6.4’U0 inceleyerek siz de raportlamada kullanacaginiz farkli bir bi-

rim desenin eskizlerini ¢iziniz.

Eskizlerden belirlediginiz bir motifi bilgisayara aktariniz.

4. Vektorel programda 10 x 10 cm dlcilerinde, 300 ppi, renk modu CMYK
olan bir dosya aginiz.

5. Dosyayi bilgisayarda uygun yere, vektdrel tabanli programin kendi forma-
tinda kaydediniz.

6. Calisirken oturma pozisyonunuza dikkat ediniz, yanlis oturus sekli sagli-
giniz igin zararhdir.

7. Vektérel programda birim motifinizi gizip renklendiriniz.

8. Vektdrel programda A3 boyutlarinda, 300 ppi, renk modu CMYK olan yeni
bir dosya aciniz.

9. Dosyayi, bilgisayarda daha 6énce birim motif icin dosya actiginiz yere,
vektdrel tabanli programin kendi formatinda kaydediniz.

10. Cetveli gérunur héle getirerek kilavuz ¢izgilerinin yerlerini belirleyiniz.

11. Gerekli ise kilavuz ¢izgileri yardimi ile aks cizgilerini olusturunuz.

12. Birim motifinizi kopyalayarak cogaltip tam (duz) raportlama teknigine uy-
gun duzenlemenizi yapiniz.

13. Calismaniz slresince sabirli ve dikkatli olmaya 6zen gésteriniz.

14. Olusturdugunuz kompozisyonu JPEG formatinda kaydediniz.

w

Degerlendirme

Uygulama c¢alismanizin siresi égretmeniniz tarafindan belirlenecektir. Calisma-
niz, 1. EK’te verilen “Dereceli Puanlama Anahtari” veya “Kontrol Listesi’ndeki 6l-
cUtlere gore degerlendirilecektir. Calismanizi yaparken bu 6lgitleri dikkate aliniz.

anttim Grafigi
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6.2. YARIM (SOTER) RAPORT SISTEMi

Raportlama tekniginde kullanilacak amblem, logo veya desenin; enine veya boyuna 1/2 oraninda
kaydiriimasi ile olusan sistemdir. Birim motif, alti akstan olugur. Tam (duz) raport dért akstan mey-
dana gelirken yarim raportta desenlerin ortasinda iki aks daha vardir. Desen, bir ydne dogru tam
(diz) raportlama sistemine uygun siralanirken diger yonde yarim kaydirilarak yuzeye siralanir
(Gorsel 6.5).

S?ZXVL NV A/
LN LA/ LN /X
AN NN/

ANVITIACIAXTIAX

Gorsel 6.5: Yarim (soter) raport sitemi

6.2.1. Yarim (Soter) Raport Sisteminin Uygulama Asamalari

Yarim (soter) raport sistemine gére desen hazirlanirken 6ncelikle amblem, logo ya da desenin 6l-
culeri belirlenir. Tekrar edecek olan birim motif icin kilavuzlar yardimiyla akslar olusturulur (Gérsel
6.6). Desende kaymalar meydana gelmemesi icin akslar olusturulurken hata yapmamaya dikkat
edilmelidir.

anttim Grafigi

Gorsel 6.6: Yarim (soter) raport sisteminde akslarin hazirlanmasi

160




1914015 sE%LI

RUNUASUARUAANANANY
vXLﬁXqu XAWX ><P< Ava
AAWX VAWXA ><]) XAvXuﬁvA
<7 XAWVA XuﬁX VAU:WX ﬁX
AAﬁXuﬁXuﬁXuﬁXuWXuWXA.wXuﬁ
DABIBABABABIBAS
A.WX DA< WvAﬁXuﬁ
vXAﬁXu.ﬁXuWXuWX@..WXAWXUVVA
AL AN
NN
><D< LVXQVXQWX <) WvAqu
ABABABICIBACACL
P
e
A;:\XVX LA
VXLWXU_WXAWXAWXAWXAWXA_,,X
AAWX ﬁvAWXAWXuﬁXAWXAv XAW
SASASASASASASABS
QORI
7XAWXA XAﬁXuWXuﬁXu Xuﬁvn
~ AN ANSANSAN
vXqu VX XL ><0<30)
XuﬁXA XAWXAVXAVXQWX\
<4 \.7 < Xu XAVXAW
/:\ IO PN,
>AAD<C XAWXAWXAWXU,WX
uwXAﬁXuﬁvAquuv XAWVA <3t
XQVXAWXA Xqu XuﬁX\
uvxu XquLwquX o<
>AOAD>AAADAC N
l?.m\.v,,m;v(;?,m;?w\,../WAvmw\,v,m.

161

RATPORTLAMA TERNIKLER]

Gorsel 6.8: Yarim (soter) raportlama

Gorsel 6.7: Yarim (soter) raportlama sistemi

Oncelikle amblem, logo ya da desen; kaydirma yapilmayacak sekilde (enine veya boyuna) diiz
raportlamada oldugu gibi siralanir. Yarim raport sistemi uygulanacak bélimde ise motif, ortalara

cizilen akslar yardimiyla Gorsel 6.7’deki gibi yarisi kadar kaydirilarak siralanir.

Yarim (soter) rapolartma yapilirken, raport disina tasan motiflerde amblem, logo veya desenin
genel yapisini bozmadan, motif ekleyerek veya cikararak dizenlemeler yapilabilir (Gérsel 6.8).
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Goérsel 6.9: Ambalaj raportlama

2. Etkinlik
W

Daha o6nce calistiginiz bir amblem veya logoyu seciniz. Vektérel tabanli
programda sectiginiz lriine uygun boyutlarda bir dosya aciniz. Yarim (so-
ter) raportlama teknigine uygun ambalaj kagit diizenlemesi yapiniz.

4

anttim Grafigl
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Raportlama Ornekleri
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Gérsel 6.10: Tam (dlz) raportlama
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Gorsel 6.13: Yarim (soter) raportlama
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Gorsel 6.14: Yarim (soter) raportlama
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Gorsel 6.16: Yarim (soter) raportlama

anttim Grafigi
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OGRENME BiRiMi: RAPORTLAMA TEKNIKLERI

S UYGULAMA ADI : Bilgisayarda Yarim (Soter) Raport Yapma
é AMAC : Raportlamada kullanilacak deseni yarim (soter) raport sistemine
== gbre yapmak.
S
S>>  Arac Gereg
= o
= 1. Bilgisayar
. 2. Tarayici
N 3. Grafik tasarim programlari
4. Kagit
5. Kalem
6. Cetvel
7. Gonye

Asagidaki igslem basamakla-
rini dikkate alarak raportlama

calismasi yapiniz. Gérsel 6.17: Yarim raportlama teknigine uygun
ambalaj kagidi

islem Basamaklari

1. Atblye 6nluglnizl giyiniz; arag gerecinizi, galisma alaninizi is saghgi ve
glvenligi tedbirlerini alarak 6zenle hazirlayiniz.

2. Gorsel 6.17’yi inceleyerek siz de raportlamada kullanacaginiz farkl bir bi-

rim desenin eskizlerini ¢iziniz.

Eskizlerden belirlediginiz bir motifi bilgisayara aktariniz.

4. Vektorel programda 10 x 10 cm 6l¢llerinde, 300 ppi, renk modu CMYK
olan bir dosya aciniz.

5. Dosyayi bilgisayarda uygun yere, vektorel tabanli programin kendi forma-
tinda kaydediniz.

6. Calisirken oturma pozisyonunuza dikkat ediniz, yanhs oturus sekli sagligi-
niz icin zararldir.

7. Vektdrel programda birim motifinizi gizip renklendiriniz.

8. Vektodrel programda A3 boyutlarinda, 300 ppi, renk modu CMYK olan yeni
bir dosya aciniz.

9. Dosyayi, bilgisayarda daha énce birim motif icin dosya actiginiz yere, vek-
torel tabanh programin kendi formatinda kaydediniz.

10. Cetveli gérindr héle getirerek kilavuz gizgilerinin yerlerini belirleyiniz.

11. Gerekli ise kilavuz gizgileri yardimi ile aks cizgilerini olusturunuz.

12. Birim motifinizi kopyalayarak cogaltip yarim (soter) raportlama teknigine
uygun diizenlemenizi yapiniz.

13. Calismaniz slresince sabirli ve dikkatli olmaya 6zen gésteriniz.

14. Olusturdugunuz kompozisyonu JPEG formatinda kaydediniz.

w

Degerlendirme

Uygulama calismanizin siresi 6gretmeniniz tarafindan belirlenecektir. Calisma-
niz, 1. Ek’te verilen “Degerlendirme Formu” veya “Kontrol Listesi’ndeki 6l¢itlere
gore degerlendirilecektir. Calismanizi yaparken bu 6lcltleri dikkate aliniz.

anttim Grafigi
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OLCME VE DEGERLENDIRME

A) Asagida verilen ciimlelerin basindaki parantezlere ciimleler dogru ise “D”, yanhs
ise “Y” yaziniz.

1. ( ) Raportlama; motiflerin yakinlk, uzaklik, buyuklik, renk ve gruplanma gibi 6zellikle-

rinin farkli sekillerde diizenlenmesi islemidir.
2. () Raportlama yapildiktan sonra basilacak ylzey, bu ylzey malzemesine uygun
ba- sim yapacak makinenin 6zellikleri ve yizeyin formu énemlidir.

3. ( ) Yarim rapolartma yapilirken, raport disina tasan motiflerde amblem, logo veya de-
senin genel yapisini bozmadan, motif ekleyerek veya c¢ikararak dizenlemeler yapilabilir.

B) Asagida verilen cimlelerde yer alan bosluklari uygun ifadelerle doldurunuz.

4. Desen motiflerinin enine, boyuna ve esit araliklarla tekrar eden en kiclUk parcasina

5. Amblem, logo veya desenden olusan birim motifin enine ve boyuna siralanmasi ile olus-
turulan raport ... sistemidir.

C) Asagida verilen sorularin dogru cevaplarini isaretleyiniz.

6. Siklikla kullanilan raport ¢esitleri asagidakilerden hangileridir?
A) Diyagonal ve ¢evirme
B) Diyagonal ve yarim
C) Tam ve diyagonal
D) Tam ve yarim
E) Tam, yarim ve diyagonal

7. Raportlama tekniginde kullanilacak amblem, logo veya desenin enine veya boyuna

1/2 oraninda kaydiriimasi ile olusan raport sistemi asagidakilerden hangisidir?
A) Tam raport
B) Yarim raport
C) Diyagonal raport
D) Cevirme raport
E) Kapaklama raport

D) Asagida verilen sorularin cevaplarini noktali yerlere yaziniz.

8. Yarim raport sisteminde siralama enine ve boyuna nasil yapilir? Aciklayiniz.

anttim Grafigl
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1. EK

O reeesesrasesessasesesssnesenssenses “UYGULAMASI
DEGERLENDIRME FORMU

Yoénerge

Uygulama faaliyeti sonunda 6grenci basarisini asagidaki Olgitleri dikkate ala-
rak; 1 (GELISTIRILEBILIR), 2 (ZAYIF), 3 (ORTA), 4 (yn, 5 (COK iYi) seklinde
puanlayayip form sonundaki degerlendirme yénergesine gére degerlendiriniz.

OLCUTLER

DERECELER

1 2

3

4

Alinan
Puan

Giris

Uygulamaya yonelik ara¢ gereci
getirdi.

Konuya iligkin 6n arastirmalar yapti.

Konu ile ilgili 6zgiin eskiz
caligsmalari yapti.

Tasarim ilkelerini eskiz calismalarina
uyguladi.

Gelisme

Eskiz calismasini uygun bilgisayar
programina aktardi.

Bilgisayar programinda uygun menii
araclarini kullandi.

Calismay ilgili bilgisayar
programinda amaca uygun olarak
tamamladi.

Sonug¢

Calismayi uygun dijital formatta
kaydetti.

Calismanin istenen 6zelliklere uygun
baskisini aldi.

Zamani planh ve verimli kullandi.

Calismayi temiz ve diizenli teslim
etti.

Atdélye ortamini temiz ve diizenli
birakti.

Toplam Puan

Degerlendirme

Tabloda her 6l¢itten alinabilecek en yiksek puan 12 x 5 = 60'tir.
PUAN = [(Genel puan toplami x 100) / Alinabilecek en yiksek
toplam puan] formli uygulanarak 100’lik sisteme dénUstiraldr.
NOT: Bu puanlama anahtarindan 100 (izerinden 70 alirsaniz
eksiklerinizi tamamlayarak bir sonraki konuya gegebilirsiniz. 69 ve

altinda puan alirsaniz ilgili konu tekrar edilmelidir.
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KONTROL LISTESI

Yoénerge
Asagidaki gbzlenecek davraniglardan 6grencinin kazanabildigi beceriler icin EVET
kazanamadigi beceriler icin HAYIR kutucugunu (X) isaretleyiniz.

GOZLENECEK DAVRANISLAR EVET HAYIR

Uygulamaya yénelik arac¢ gereci getirdi.

Konuya iligskin 6n arastirmalar yapti.

Konu ile ilgili 6zgiin eskiz calismalari yapti.

Tasarim ilkelerini eskiz calismalarina uyguladi.

Eskiz calismasini uygun bilgisayar programina aktardi.

Bilgisayar programinda uygun menii araclarini kullandi.

Calismayi1 amacina uygun ilgili bilgisayar programinda
tamamladi.

Calismayi uygun dijital formatta kaydetti.

Calismanin istenen 6zelliklere uygun baskisini aldi.

Zamani planh ve verimli kullandi.

Calismayi temiz ve diizenli olarak teslim etti.

Atélye ortamini temiz ve diizenli birakti.

Degerlendirme 12 dlgutten toplam 2 ve Ustl sayida HAYIR varsa uygulamada BASARISIZ
olunmustur.
Not: Uygulama sonucunu BASARISIZ ise, basarisiz oldugunuz konulara
geri donup bu konulari tekrar ediniz. BASARILI ise, bir sonraki Uiniteye ge-
cebilirsiniz.

anttim Grafigi

172




B
-

1. EK

AMBALAJ MAK_ETi HAZIRLAMA
DEGERLENDIRME FORMU

Yoénerge

Uygulama faaliyeti sonunda 6grenci basarisini asagidaki Olgitleri dikkate ala-
rak; 1 (GELISTIRILEBILIR), 2 (ZAYIF), 3 (ORTA), 4 (iYi), 5 (COK iYi) seklinde
puanlayip form sonundaki degerlendirme yénergesine gére degerlendiriniz.

DERECELER
OLCUTLER T T3 T 4 T 5 Pum

Giris
Uygulamaya yonelik ara¢ gereci
getirdi.

Konuya iligkin 6n arastirmalar yapti.

Konu ile ilgili 6zgiin eskiz
caligsmalari yapti.

Tasarim ilkelerini eskiz calismalarina
uyguladi.

Gelisme

Uriine uygun renk segimi yapti.

Maketin acik haline kirim ve kesim
yerlerini ¢izdi.

Maketin kirirm ve kesim islemini
uyguladi.

Yapistirma islemini yaparak makete
son halini verdi.

Sonug¢

Zamani planli ve verimli kullandi.

Calismayi temiz ve diizenli teslim
etti.

Atblye ortamini temiz ve diizenli
birakti.

Toplam Puan

Puanlama Tabloda her 6lgutten alinabilecek en ylksek puan 12 x 5 = 60'tir.
PUAN = [(Genel puan toplami x 100) / Alinabilecek en ylksek toplam
puan] formili uygulanarak 100’lik sisteme dénustiralir.

NOT: Bu puanlama anahtarindan 100 Gzerinden 70 alirsaniz eksik-
lerinizi tamamlayarak bir sonraki konuya gegebilirsiniz. 69 ve altinda
puan alirsaniz ilgili konu tekrar edilmelidir.
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AMBALAJ MAKETi_ HAZIRLAMA
KONTROL LISTESI

Yonerge
Asagidaki gbzlenecek davraniglardan 6grencinin kazanabildigi beceriler icin EVET
kazanamadig! beceriler icin HAYIR kutucugunu (X) isaretleyiniz.

GOZLENECEK DAVRANISLAR EVET HAYIR

Uygulamaya yonelik ara¢ gereci getirdi.

Konuya iliskin 6n arastirmalar yapti.

Konu ile ilgili 6zgiin eskiz calismalari yapt.

Tasarim ilkelerini eskiz calismalarina uyguladi.

Uriine uygun renk secimi yapti.

Maketin acik héaline kirnm ve kesim yerlerini gizdi.

Maketin kirim ve kesim islemini uyguladi.

Yapistirma islemini yaparak makete son hélini verdi.

Zamani planh ve verimli kullandi.

Calismayi temiz ve diizenli olarak teslim etti.

Atélye ortamini temiz ve diizenli birakti.

Degerlendirme 12 dlgltten toplam 2 ve Ustl sayida HAYIR varsa uygulamada BASARISIZ
olunmustur.
Not: Uygulama sonucunu BASARISIZ ise, basarisiz oldugunuz konulara
geri donlp bu konulari tekrar ediniz. BASARILI ise, bir sonraki Uniteye ge-
cebilirsiniz.
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(EVAT ANARTAR
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duvar
gorsel
tipografik

. Kuruma ait 6zel bir font varsa o kullaniimalidir,

yoksa kuruma uygun olan font secilmeli-
dir. Segimde takvim ¢esidi de g6z 6niinde
bulundurularak yazilarin okunakli, anlasihr
ve gorilebilir olmasi dikkate alinmalidir.
Calismanin toplam baski adedine, baski
makinesinin 6zelliklerine, ciltleme cesidine,
kullaniimak istenen malzeme ve élglye
gbre duzenleme yapilr.
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goruntl diizenleme
biytklik

reklam afisleri

eskiz

. materyal

. D

. A

. Sosyal afigler toplumda farkindalik yarat-

mak, insanlarin bazi konulara daha duyarli
olmalarini saglamak icin hazirlanir. Reklam
afigleri ise Urtin ya da hizmeti tanitmay
amagclayan satis yapmaya yoénelik afiglerdir.

. Baskalasim tasarimlarin daha orijinal olma-

s1, hedef kitlenin dikkatini cekmesi, akilda
kahcihgin artinimasi igin yapihr.
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kagit ve turevi

seffaf etiket

C

C

Plastik bazh etiketlerin dayanikhhgr ka-
git bazl etiketlere oranla daha fazladir.
Dayanikli olmasi sayesinde genellikle
sanayi, kozmetik ve kimya sektorinde
kullanilr.

Markanin logosu dikkat cekecek bir sekilde
kullaniimalidir.

Yapilacak etiket, trtintn temel bilgilerini
ve Ozelliklerini yansitmalidir; yazilar agik
ve oku- nabilir olmalidir.
Kullanilan gérseller ilk izlenimde dikkat
cekmeli ve bilgilendirici olmalidir.
Tasarim tzerinde kullanilan renkler dikkat
cekmelidir.

Segilen yazi tipi tasarimla uyumlu olmalidir.
Uriin hakkinda verilecek énemli bilgiler
en Uste blyuk puntolarla yazilmali,
diger bilgiler ise uygun puntolarla sira-
lanmalidir.

Yeterli oranda beyaz alan birakiimalidir.
Firmaya ait iletisim bilgileri acik ve net bir
bicimde olmalidir.
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aliminyum

plastik

viyol

cam

estetik
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Pencereli kutu: Uriiniin gériinebilmesi igin kul-
lanilan, ayrica farkl tasarim imkanlari sunan
bolimdur. Kutu ambalajlarda paketi agmadan
Grlind tuketicinin gérmesine olanak saglar. Pen-
cere icin belirlenen alan genellikle 6n yluzde
bulunur. Kutu igcindeki Griiniin kutudan ¢ikmasini
O6nlemek icin genellikle saydam bir malzeme ile
kapatilir.

Separatdr: Ambalaj ile Uriin arasina yerlestiri-
len karton, oluklu mukavva, strafor ya da hava
yastigina separator denir. Carpmalara, disme-
lere karsi Urtiintin zarar gérmesini 6nlemek icin
separator kullanilir.

14. Sektor analizinde detayli arastirmalar yapilarak

elde edilen veriler dosyalanmalidir. Bir Griin-
den her acidan maksimum fayda saglamak
adina ambalaj, bu veri dosyasindaki bilgiler
dogrultusunda tasarlanmalidir. Sektér analizinde
arastirimasi gerekenler sunlardir:

Uriin ile ilgili mevcut bitiin 6zellikler ve ben-
zerlerinden ayrilan 6zellikler

Hedef kitle ile ilgili demografik 6zellikler basta
olmak Uzere Uriinden beklenenler

Pazar ile ilgili pazar olarak kabul edilecek bolge
basta olmak tizere Uriin ile ayni ve benzer olan
Urlnlerin pazar paylari ve satis cirolari

Uretici firmanin kisa ve uzun vadede (riinden
net beklentileri
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12.

O < U O

metin alani

psikolojik etkilerinin

illistrasyon

A

D

Yapisal tasarimi tamamlanan ambalajin
grafiksel tasarimina gegilir. Her bir ylizey
Olcusline goére ayr ayri tasarlanabilecegi
gibi butln olarak da tasarlanabilir. Gor-
sel unsurlar yerlestirirken fotograf veya
illistrasyonun kirim yerlerine denk gel-
memesi gerekir. Tasarim plani dahilinde
fotograf veya illustrasyon kirim yerlerine
denk gelecekse ¢irkin bir gériintl olusturup
olusturmayacagi deneme baskisinda takip
edilmelidir.

Once bigak, kesim ve kirim gizgilerinin ol-
dugu sablon ¢izimi yapilir; sonra tasarim
yapilhr.

Tasarimi yapilacak Urnin tim gesitleri icin
tasarimin distnulmesi, ambalaj tasarimi
calismasinin planlamasi konsept ¢alismasi
olarak isimlendirilir.
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raport

tam (duiz) raport

D

A

Desen, bir yéne dogru tam (dtiz) raportlama
sistemine uygun siralanirken diger yénde
yarim kaydirilarak ylzeye siralanir.
Grafik alaninda raportlama, Griinlerin toplu
halde paketlenmeleri esnasinda kullani-
lan ambalaj kagitlarinda, ambalaj kutusu
zemin diizenlemelerinde, kaplama mal-
zemelerinde ve siklikla tekstil irtnlerinde
kullantlir.
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